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Backup SCCM Site Server
Restore SCCM Site Server
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1 Server Setup
1 Server built based on APSCN LAN Support installation document.

2 Server Volumes

e (: 100 GB - System (recommended at least 100 GB in production environment)
e (Q: 100 GB -SQL Database (recommended at least 100 GB in production)

e S: 200 GB —SCCM Installation & Distribution Files (recommended at least 200 GB)

3 Server must be FULLY patched (including .NET Frameworks 4 — All Windows Updates Ran).

4 If Server OS was from an image, SYSPREP must be run on target hardware.

5 Verify Active Directory Sites and Services Configuration. Sites must be created, and subnets
assigned.

6 Verify in DNS that reverse lookup zones have been created for IP Subnets.

7 If Windows Firewall (or any software-based firewall), ensure that proper ports are opened
to client stations.

8 SQL Server and SCCM installed on same physical hardware and Windows installation
instance.

1.1 Creating Needed Active Directory Objects

1.1.1 Add Users & Groups to Active Directory
*0On DC-1 Domain Controller

1
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Create Security Group "MSSQL Admins"

Create User "MSSQL Admin" (Used for MS SQL Service Account).

Add "MSSQL Admin" User to "MSSQL Admins" Security Group

Create Security Group "SCCM Admins"

Create User “SCCM Admin” (Used to give SCCM admin rights on all workstations).

Add “SCCM Admin” user account to Domain Admins Security Group, MSSQL Admins
Security Group, and SCCM Admins Security Group. (This can be tightened down later)

Create Security Group "SCCM Servers" and add your SCCM Server/Servers to be
members of “SCCM Servers” Security Group.



1.1.2 Set SPN Attributes
*On DC-1 Domain Controller

1 Open Active Directory Users and Computers

2 Click on View on the menu bar

3 Click Advanced Features

4  Find the <YOUR_DOMAIN>\MSSQL Admin user

5 Right Click and Click Properties

Published Certficates | Member OF | Password Replication | Diakin | Object I
Security Environment Sessions
Remote control | Remote Desktop Services Profile |
General | Address | Accourt | Profile | Telephones | Organization |
Personal Vitual Desktop | COM+ Attribute Editor
Atributes:
Atribute | Value :I
seeflso <not set>

serialNumber <not set>

servicePrincipalName <ot set>

6 Attribute Editor tab -> ServicePrincipalName -> Edit. Add the following:

Multi-valued String Editor x|
Mtribute: servicePrincipalName
Value to add:
[ Add
Values:
MSSQLSve/SCCM-A1 Femoyve
MSSQLSve/SCCM-A-1 school local
MSSQLSve/SCCM-A-1 school local: 1433
MSSOLSve/SCCM-A-1:1433

e MSSQLSvc/<YOUR_SCCM_SERVER>
o MSSQLSvc/<YOUR_SCCM_SERVER>.<YOUR_DOMAIN>.local
e MSSQLSvc/<YOUR_SCCM_SERVER>.<YOUR_DOMAINS>.local:1433

e MSSQLSvc/<YOUR_SCCM_SERVER>:1433
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1.1.3 Create System Management Container
*On DC-1 Domain Controller

Create System Management Container in ADSI Editor and Add “SCCM Servers” Security group to
System Management with Full Control to this object.

1 Click ADSI Edit and Connect to Default naming context. Click OK

2 Double Click Default naming context and browse down and find CN=System

3 Right Click System and Select New -> Object-> Container. Click Next

4 Name the Container System Management and Click Next and Finish.

5 Right Click this new container and Click Properties. Go to the Security Tab.

6 Click Advanced-> Add. Click on Select a Principle and add SCCM Servers group object.

7 Allow Full control and make sure the Applies to drop down box is set to This object and
all descendant objects. Click and Ok then exit ADSI Edit.

i Permission Eatry for System Management o x

Principsk  Scem Servers (DOMAIN\Scem Sarvers]  Select a principal
Type Allow -

Appliec to: This abject and all descerdant objects

Permissions:

(2] Delete mzDS-ClsimTypes objects

st contents (A Creste me0S-DeviceRegistretonServiceContainer objects

lead sll properties 7] Delete mzDS-DenceRegstrationSenaceContainer objects
[ Write all propesties
4 Delete

=
=)

= -GroupManagedServiceAccount object
%]

4 Delete subtree

=z

=

05-
te msDS-KeyCredential objects

upManagedSericehccount objects

Credential abjects
~ManegedSericeAccount objects
nagedServiceliccount objects

rdSettingsContaines object

SettingsContaines objects
ceProperties abjects
-ResourceProperties objects

elete sccount chjects (4] Create mzDS-RescurcePropertytiz: objects

[ Creste aCSPolky objects A Oelete m curcePropertyList objects

{7 Delete sC5Policy objects 7] Creste msDS-ShadewPrincipalContainer objects v

Cancel
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1.2

1.3

=

Prepare Active Directory Schema
* On the Doman Controller running the Schema Master role: (netdom /query fsmo)

1

8

Mount SCCM Installation ISO

Open Command Prompt

Use command CD to change directory to newly mounted ISO
Type CD SMSSETUP\BIN\x64 and Press Enter

Type EXTADSCH.EXE and Press <enter>

**Close the command prompt when you receive the Successfully extended the Active
Directory schema message.

You can check the log file for errors at C:\ExtADSch.log

Unmount the SCCM Installation ISO

Prepare SCCM Server for Multiple Sites/Servers
*0On SCCM Servers, Add object to the Local Administrators Group

Right click the start/Windows button

Click Computer Management

Select Local Users and Groups -> Groups -> Administrators

Click Add

Add the following to the local Administrators Security group.

1.a <YOUR_DOMAIN>\MSSQL Admins
1.b <YOUR_DOMAIN>\SCCM Admins

1.c <YOUR_DOMAIN>\SCCM Server
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1.4 Limit Drives for Site Server Roles
*On <YOUR_SCCM_SERVER>

To prevent Configuration Manager from installing files on a specific drive.
1 Inanew File Explorer screen click View -> Change Folder and Search Options

2 Click the View tab -> Select Show hidden files, folders, and drive -> UNCHECK the box
next to Hide extensions for known file types

3 Click Apply -> Ok
4 Navigate to System Drive (C:) -> Right click and select New -> Text Document

5 Name this document no_sms_on_drive.sms (Make sure the file extension is .sms NOT
.txt) Click Yes when prompted about the file becoming unusable.

6 Copy the no_sms_on_drive.sms file at the root folder of the SQL Drive (Q:) and any other
drive that you want to prevent Configuration Manager from installing files on. This will
include any USB or External Drives you have connected to the server.

1.5 Install Role & Feature prerequisites

1.5.1 Add Features and Roles
*On <YOUR_SCCM_SERVER> — Be sure to be logged in as DOMAIN Administrator I.E.
<YOUR_DOMAIN>\Administrator. DO NOT LOG IN AS YOURSELF EVEN IF YOU ARE A MEMBER
OF THE DOMAIN ADMIN SECURITY GROUP!! This applies to any install and management of any
server related tasks including SQL, SCCM, etc.

1. Mount Windows Server (2016/2012) ISO for future use

2. In Server Manager, select Manage -> Add Roles and Features

3. Select Role-based or feature-based installation -> Next

4. On the Server Selection page make sure your server is selected -> Next

5. Select the box next to Windows Server Update Services (Click Add Features in the
pop-up)

6. On the Features page, select the following features:

A. Select .Net Framework 3.5 Features

e .Net Framework 3.5 (this is listed under the .Net Framework 3.5
Features)

e HTTP Activation (Click Add Features in the pop-up)
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B. Select Background Intelligent Transfer Service (BITS) - (Click Add Features in
the pop-up)

C. Select Remote Differential Compression
D. Click Next

7. On the WSUS page click Next

8. On the Role Services page click Next

9. On the Content page type <Your_SCCM_Volume_Drive_Letter>:\WSUS in the empty
box and click Next

e Add Roles and Features Wizard - (] >
e SRR (WS ([ (IO - DESTINATION SERVER
Content location selection 20105CCM.domainiocal

1# you have a drive formatted with NTFS and at least 6 GB of free disk space, you can use it t5 store
updates for client computers to download quickly.

If you need to cave dick epace, clear the check box to store updates on Microsoft Update;
downloads will be slower

If you choose to store updates locally, updates are not downloaded to your WSUS server until you
approve them, By default, when updates are approved. they are downloaded for all languages.

[]Store updates in the following location (choose a valid local path on 20165CCM.domain local, or
a remote path) :

SAWSUS

l < Previous ‘ | Next = Insta J Cancel

10. On the Web Server Role (IIS) page, click Next

11. On the Role Services page, leave the defaults already selected and select the following
additional options:

A. Under Common HTTP Features select:
e WebDAYV Publishing
B. Under Application Development select:
e ASP
C. Under Management Tools -> IIS 6 Management Compatibility select:
e 1IS 6 WMI Compatibility
D. Under Management Tools select:
e |IS Management Scripts and Tools
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12. On the Confirmation page you will see a yellow banner across the top asking if you
need to “specify an alternate source path?” You do need to do this.

A.

B.

Select Specify an alternate source path in blue letters at the bottom of the
page

In the Path text box, type <Your_Mounted_ISO_Drive_Letter>:\Sources\SxS

fZ=: Add Roles and Features Wizard

Specify Alternate Source Pat

Some servers might not have all source files available to add all roles, role services, or features. The source files
might not have been installed, or might have been removed by users after the operating system was instailed.

If the server on which you want to install roles or features does not have all required source files, the server can
try to get files by using Windows Update, or from a location that is specified by Group Policy.

You can also specify an alternate path for the source files, if the destination server does not have them. The

source path or file share must grant Read permissions either to the Everyone group (not recommended for

security reasons), or to the computer (local system) account of the destination server; granting user account
access is not sufficient.

The following are examples of a valid source file path where the destination server is the local server, and where
the E: drive contains the Windows Server installation media.

Source files for NET Framework 3.5 Features are not installed as part of a typical installation; but are available in
the side-by-side store (SxS) folder
E\Sources\SxS\

Source files for other features are available in the Install.wim file. Add the WIM: prefix to the path, and a suffix to
indicate the index of the image from which to get source files. In the following example, the index is 4
WIM:EASources\Install.wim:4

|

Path: |D:\Sources\SxS

oK | | Cancel

13. Click OK -> Install.

14. After the install completes, go to your Server Manager, click the flag in the top right
and run Post-Installation Configuration

15. Restart your server upon completion.

1.6 Install Microsoft SQL Server
*On <YOUR_SCCM_SERVER>
Verify that Windows Firewall is disabled for SQL Installation.
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Mount the SQL Server 2016 Installation ISO on your SCCM Server.

Navigate to the mounted ISO and run setup.exe

NOTE: You may be prompted to enable .NET Framework Core role. Click OK on this

message.
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Once the SQL Server Installation Center screen comes up, click Installation on the left
side of the window.

Click New SQL Server stand-alone installation or add features to an existing
installation.

Enter the Product Key from your Volume Licensing Agreement Portal -> Next
Put a check in the box next to | accept the license terms -> Next

SQL 2016 will auto update and install needed files. Wait for it to complete.

10 On the Feature Selection page, select the following:

A. Check the box next to Database Engine Service

B. NOTE: If you are using SQL 2012 or 2014, you will also need to select
Management Tools and Reporting Service.

C. NOTE: If you are using SQL 2016 or above, Management Tools and Reporting
Service will be a separate install.

11 Change your Instance root directory drive letter to that of your SQL partition (Q:\) and

delete Program Files from the path already listed. Click Next.

5 SQL Server 2017 Setup - O X

Feature Selection
Select the Standard features to install,
Product Key

S 0 Looking for Reporting Services? Download it from the web
License Terms

Global Rules Features: Feature description:
Mi ft Update RN a =

e Instance Features " || The configuration and operation of each A
Product Updates Database Engine Services instance feature of a SQL Server instance is
Install Setup Files [[] sGL Server Replication M
Install Rules [[J Machine Learning Services (In-Database) Prerequisites for selected features:

R | —
Feature Selection g Already installed: ~
[ Python : Z 3
Feature Rules [] Full-Text and Semantic Extractions for Sez findows fowerhell 3.0 ok bigher
e 0 : : = Microsoft .NET Framework 4.6 ot
Instance Configuration [ Data Quality Services Disk 5 R
Server Configuration [[] PolyBase Query Service for Fxternal Data RT3l i Sal
Butabuse Enginc Configiiration [ Analysis Services « || Brive C: 99 MB required, 26185 MB available
<At > Drive @ 902 MB required, 15272 MB available
Feature Configuration Rules
Ready to Install
Select All Unselect All
Installation Progress
Complete Instance root directory: ]O:\Program Files\Microsoft SOL Server\ |
Shared feature directory: fQ:‘\Program Files\Microsoft SQL Server\ |

Shared feature directory (x86): iq\program Files (x26)\Microsoft SQL Server\ |

< Back Next > Cancel

12 On the Instance Configuration page, click Next
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13 On the Server Configuration page, change the Account Name, Password and Startup

Type fields to match the list below then click Next:

A. SQL Server Agent

Account Name — <YOUR_DOMAIN>\MSSQL.Admin

Enter the Password

Startup Type — Automatic

B. SQL Server Database Engine

Account Name — <YOUR_DOMAIN>\MSSQL.Admin

Enter the Password

Startup Type - Automatic

C. SQL Server Browser

i. LEAVE THE DEFAULT SETTINGS ALREADY IN PLACE

% SQL Server 2017 Setup - o X

Server Configuration

Specify the service accounts and collation configuration.

Product Key Service Accounts  Coliation

License Terms

Global Rules Microsoft recommends that you use 3 separate account for each SQL Server service,

Microsoft Update Service Account Name Password Startup Type
Product Updates SOL Server Agent schooltMSS0LAdmin essssenes Automatic v
Install Setup Files SQL Server Databass Engine school\MSSQLAdMIn oo Lutomatic v
Install Rules SOL Server Browser INT AUTHORITYALOCAL ... Disabled v
Feature Selection

Feature Rules [} Grant Perform Volume Maintenance Task privilege to SQL Server Database Engine Service
Instance Configuration This priviege enables instant file initialization by avciding zeroing of data pages. This may lead
Server Configuration to information disclosure by allowing celeted content to be accessed,

Databazse Engine Configuration Click here for details
Feature Configuration Rules

Ready to Install

Instaliztion Progress

Complete

< Back Next > Cencel




14 On the Database Engine Configuration page, select Add Current User then select Add
and add the MSSQL Admins Security Group and click Next.
Server Configuration  Data Directories TempDB  FILESTREAM

Specify the authentication mode and administrators for the Database Engine.

Authentication Mode

{®) Windows authenticaton mode

(O Mixed Mode (SOL Server authentication and Windows authentication)

Specify the password for the SQL Server system administrator (sa) account. ———————
Enter password:

Confirm password:

Specify SOL Server adminisirator

DOMAIN\ administrator (Administrator)
DOMAIN\MSSCL Admins (MSSQL Admins)

SQL Server administrators
have unrestricted access
to the Database Engine.

Add Current User Add... Remove

15 On the Feature Configuration Rules page, click Next.
16 On the Ready to Install page, click Install.

17 Verify all Features installed with a Status of Succeeded.
Information about the Setup operation or possible next steps:

I Feature Status

@ Reporting Services - Native Succeeded
@ Database Engine Services Succeeded
@ SQL Browser Succeeded
{2 5QL Writer Succeeded
@ SQL Client Connectivity Succeeded
A SOL Cliant Cannartiit: SDK Surrasdad

NOTE: The next 7 steps are for those using SQL 2016 and above ONLY

18 Open the SQL Server Installation Center window that should still be open from installing
the SQL Database above.

19 Select Install SQL Server Management Tools. This will open a browser window allowing
you to download the latest version of the SQL Server Management Studio.
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20 Select Download SQL Server Management Studio (16.5.3) Note: This version number is
subject to change at any time. Please select the latest version that states Current
release for production use.

@ Download SQL Server
Management Studio (SSMS)

Download SQL Server Management Current release for production use.
Studio (16.5.3)

Download SQL Server Management Includes support for SQL Server vINext CTP1.3, and
Studio - Release Candidate (17.0 works side-by-side with 16.x, but not recommended
RC3) for production use.

21 Save the file in your SQL Directory

22 Navigate to the download location and run the SSMS-Setup-ENU.exe that you just
downloaded.

RELEASE 16.5.3

.22 Microsoft SQL Server Management Studio

Welcome. Click "Install” to begin.

By clicking the "Install” buttor, | acknowledge that 1 accept the

SQL Server Management Studio transmits information about your installation experience, as well as other
usage and performance data, to Microsoft to help improve the product. To learn more about SQL Server
Management Studio data processing and privacy contrals, see the privacy statement link above.

Install Close

23 Click Install

24 After the automatic setup completes, Click Close.



25 Open the SQL Server Installation Center window that should still be open from installing
the SQL Database above.

26 Select Install SQL Server Reporting Services. This will open a browser window allowing
you to download the latest version of the SQL Server Reporting Services.
Microsoft SQL Server 2017 Reporting Services

Important! Selecting a language below will dynamically change the complete page content to that
language.

Select Language: English V‘

SQL Server Reparting Services is a server-based reporting platform that
provides comprehensive reporting functionality.

27 Select Install Reporting Services.

Microsoft SQL Server 2017 Reporting Services

(October 2017)

Welcome

Install Reporting Services

SQL Server Reporting Services transmits information about your installation experience. as well as other
usage and performance data, to Microsoft to help improve the product. To learn more about SQL Server
Reporting Senvices data processing and privacy controls, please see Pr Statement.

28 Enter the product key, and click Next.
29 Check box to Accept license terms, and click Next.
30 On the Install location, click Install.

31 After the install completes click Close.
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1.7 Set Microsoft SQL Server Memory Restrictions
* On <YOUR_SCCM_SERVER>

1 Click Start Menu, Select Microsoft SQL Server 2016 and select Microsoft SQL Management
Studio

Recently added

BE St Senver 2016 Profiler

B Ocployment Wiard

"{5 SQL Server 2015 Database Engine..
Expand

Most used

& snipping Tool

& ot

M

l Microsoft SQL Server 2008

. Microsoft SQL Server 2016

oft SOL Server Management Studio
‘\lxr.nor'i SOL Server Menegeme...
"Qr:pmlihg Services Configuration...
SQL Server 2016 Configuration...
! ':.';l Server 2016 Data feed Publi...
Server 2016 Data Profile Vie...

SQL Server 2016 Database Engin...

2 Click Connect

@4 Connect to Server X
SQL Server

Server type: Database Engine v

Server name: 2oi6sceM ”

Authentication: Windows Authentication ~

DOMAIN administrator

Cancel Help [ Options >>
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3 Right Click Server and Select Properties

Object Explorer - 0 X
Connect~ 35 43 (VI
=] b 20165CCM (SQL Server 13.0.40 il
(3 Databases Conrect..
@ [ Security Disconnect
@ [ Server Objects Register...
1+ [ Feplication ~
@ [ PolyBase New Qaery
# [23 AlwaysOn High Availability Activity Monitor
@ [Z3 Management
[# [ Integration Services Catalog phont
@ [$H SQL Server Agent Stop
Pause
Resume
Restart
Policies >
Facets
Start PowerShell
Reports »
Refresh
Properties

4 Select Memory, set the Maximum server memory to at least 8192 MB or % of your server’s

total memory

(] Server Properties - 20165CCM

Cot 11
| DOMAIN'scmnetrator

) Yow con LI

Ready

5 Scgt v [ Heb

Sereec momixy options

Ninmum ssrver memory 91 MEJ:
L) <
Nenamum server memory §n ME):

204 <

Cther memary cpbors
Index creelion memary (n KB, 0 = dynamic memory}
a ¥

N memory per query (n KB).
1024

® Corfgursd valses O Runing values

Corc

5 Click Ok, and Close out SQL Server Management Studio.
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1.8 Install Microsoft Administration Deployment Kit
*On <YOUR_SCCM_SERVER> — At the time of creation of this guide, WADK 2004 was the latest
version released. WADK 2004 has been tested and verified for use in a production environment by
ASPCN LAN. This guide will use WADK 2004 for this reason.

1 For SCCM Server 2103 (At the time of creation of this guide, the 2103 ISO is the latest
release from Microsoft to be installed via 1SO.)

A. Download Windows Assessment and Deployment Kit (WADK) for Windows 10
(https://go.microsoft.com/fwlink/?linkid=2086042) and Windows PE add-on for the
ADK (https://go.microsoft.com/fwlink/?linkid=2087112).

B. Create two folders called WADK and PE on your S: (SCCM) volume and download
the Windows ADK and PE for Windows 10, Version 2004 to these locations.

2 Run the adksetup.exe when the file is downloaded from the WADK folder. In the Install
Path box, leave the default location selected, and then click Next.

Specify Location

® |nstall the Windows Assessment and Deployment Kit - Windows 10 to this computer

Install Path:

C\Program Files (x86)\Windows Kits\10% Browse...

) Download the Windows Assessment and Deployment Kit - Windows 10 for installation on a separate
computer

Download Path:

wiUsers\ aCmintsiratorn. O iViAIIN

Estimated disk space required: 7.4 GB
Disk space available: 26.8 GB

3 Onthe Windows Kits Privacy page, select No -> Next

4 Onthe License Agreement page, click Accept
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https://go.microsoft.com/fwlink/?linkid=2086042
https://go.microsoft.com/fwlink/?linkid=2087112

5

10

Select the following Windows ADK features:
o Deployment Tools
e User State Migration tool (USMT)
e Volume Activation Management Tool (VAMT)

e Windows Performance Toolkit

#3) win Aszesz and Deploy Kit - Windows 10 = >

Select the features you want to install

Click a feature name for more information.

[l appiication Compatihiity Toals Microsoft User Experience Virtualization

|| Daploymant Tonis (UE-V) Template Generator

[1imaging And Configurstion Designer (1CD) Size: 11.2 MB

[[] conrguraticn Designar Microsoft User Experience Virtuabzation (UE-Y) Template
Generator

[¢] User Seate Migmtion Toal (USMT)

[¥] Voiume Activation Management Too! (VAMT) To synchronize application settings between  user
< computers, Microscft User Experience Virtuslization (UE-V)
[¥] wincows Ferfarmance Tooreit

uses settings location templates. Some sattings lccation
N You can also create, edit or validate custom settings
[T vedia experience Analvzer focation templates by usmg the UE-V Generator, The UE-Y
Generator montors Windows desktop applicatons to
discaver and capture the lacations whera the application
stores its settings. The application that is monitored must

be a desktop application.

Estimated disk space requirad: 876.2 MB
Disk space available: 21.0GB
[ ek [ st |[ cancel

Click Install and wait for the installation to finish.

¥ Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons - Windows 10 — b4

Specify Location '

@ Install the Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons -
Windows 10 to this computer
Install Pathy
CAPro Piles (x5€ 3 @\ 10

gra ex (xBE)\Windons rowse

windows Kit common installztion path used

- Downlcad the Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons -
Windows 10 for installation on a separate computer |

Download Path:

\Uzarstadministrator.SCHOOL\Dawnlaads\Windaows Kits\1 088 DKWinPEA=dons
Estimated disk space requirec: 5.7 GB
Disk space available: 20.1 GB

Run the adkwinpesetup.exe when the file is downloaded from the PE folder. In the Install

Path box, leave the default location selected, and then click Next.
On the Windows Kits Privacy page, select No -> Next
On the License Agreement page, click Accept.

Make sure (Windows PE) is checked and click Install.
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11 This will take some time to download the PE images. Click Close when it finishes.

) Windows Assessment and Deployment Kit Windows Preinstallation Envirenment Add-ons - Windows 10 - =

|

Select the features you want to install

Click a feature name for more information.

[l wi Preir ) Environment (Wi ) Windows Preinstallation Environment
(Windows PE)
Size: 5.7 GB

Minimal operating system designed to prepare 3 computer
for installation and servicing of Windows,

Includes:

Windows PE (x86)
Windows PE (AMD6GS)
Windows PE [ARM)
Windeows PE [ARMG64)

Estimated disk space required: 5.7 GB
Disk space avaiiable: 20 GB
Back l I Install I l Cancel
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2 Install SCCM

2.1 Create a Downloads folder in root of the S: Drive.
During the installation of SCCM, you will need to download update files. This folder has to be

created before the install begins.

2.2 Download SCCM
In your EES Portal (Microsoft Agreement) — Volume Licensing Portal

e Search for System Center Config Mgr (current branch)

o Select Download and this will drop down multiple options for you to choose from.

Expart all keys: C5U 1-10f 1 it=ms

_ Prod;lct Description Download Key

Systam Cantar Contin Mar (v System Centes Config Mgr (cusrent branch) Desciiptior Download Ky
= Al Products (649) Special Instructions
Business Salutiors (8) NS Proiiai,
Developer Tools (12)
Offce (112) Download Settings
Fervers: GIN Microsoft recommends using a Downioad Manager if you would ke to downioad multiple files or large file sizes
ftware Assurance (93) automatically restart the download f interrupted, or pause, start and stop downloads.

s (137)
Windows Server [62)

For mformation an the download formats, please visit the Downdosds FAQ,

Download Method 7 Langusge Operating System Type

| Web Browser v| [Engesn v v
Continus
Files 0s Size  Format ?  Download SHA1 Hash
SGL Server Standord Edition 2017 64 Bit English p4bit 1474 MB 150 @ 5]
13 r DataCenter Core 2018 - Virtual Machme T
B4 bit 052 50 0 i
M erver Multilangusge By EnR L » 0
System Center Cenfig Mgr |, ent ch 1902, N
Sys ter Config Mgr {current branch 1902) 54 bt 1612 MB 150 ® @

MuitiLangusge

e Select the highest version available to you. At the time if this writing 2103 was
available. This guide will use Version 2103

2.3 Install SCCM
1. Mount your SCCM ISO and navigate to the root of the ISO

2. Run Splash.hta to start the install.

3. Click Install when the splash screen appears.

Microsoft System Center
Configuration Manager

Wersion 1902

Install
@ Restart may be required
@ Before you begin

4. On the Before You Begin screen, click Next.
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5. Onthe Getting Started screen, click Next.

6. On the Product Key screen, enter your valid product key and click Next.
7. Onthe Product License Terms screen, Accept all terms and click Next.

8. Enter S:\Downloads and click Next. (This folder must already exist.)

Setup requires prersquisite files Setup can automatically downfoad the files to a location that you specify, or you can
use files that have been downloaded praviously

(®) Downlaad raquired files

Example: WSarverName\Sharehiame or CAD

Path; hdownleads Browse.. |

) Use previously downloaded files

Example: WSerrerName\SharaName or CADownloads

Pati:

9. On the Server Language Selection screen, click Next.
10. On the Client Language Selection screen, click Next.

11. One the Site and Installation Settings screen, enter the

e Site Code (Three unique letters that correspond to your District Name)

e Site Name (Your School Districts Full Name)

e Installation folder drive to S:\Microsoft Configuration Manager.

e Click Next.

Systern Canter Configuration Manager Setup Wizard
Site and Installation Settings

Specify  site code thet uniquely identifies this Configuration Manager site in your hierarchy.

Site coda [psd

Specify w site name that helps fo ideniify the site.  Example: Cortors Headaquarters Sita

Site name- Public School Distnct

Note: The zite code must be unigue in the Tonfiguration Mansger hierarchy snd cannot be changed after you Install the

Installsticn foider [St\Microzaft Configuration Manager Erowme.

Specify whether to instail the Configuration Manager contole 1o manage the Configuration Manager site from this
computer. You can ramotely manage the site when you do not install the Configuration Manager conzole

¥] Install the Contiguration Manager console

12. On the Primary Site Installation screen, select Install the primary site as a stand-alone
site, and click Next.

" Join the primary site to an existing hierarchy

Central administration site server (FQDN): (Example: serverl.corp.contos




13.

14.

15.

16.

17.

Click Yes to the Pop-up.

On the Database Information screen, click Next.

On the second Database Information screen, Click Next.
On the SMS Provider Settings screen, click Next.

On the Client Computer Communication Settings screen, Select Configure the
communication method on each site system role. Make sure the sub-option check box
is unchecked, and click Next.

Configuration Manager site system roles can accept HTTP or HTTPS communication from clients. Specify whether to require
all site system roles to accept only HTTPS communication or allow the communication method to be configured on each site
system role.

€ Al site system roles accept only HTTPS communication from dients

[~ Clients will use HTTPS when they have a valid PKI certificate and HTTPS-enabled site roles are avaiable

Mote: HTTPS communication requires client computers to have a valid PK] certificate for client authentication.

**If you are doing the SSL (Certificates) do not clear the “Clients will use HTTPS when they have a valid
PKI certificate and HTTPS-enabled site roles are available”

18

19

20

21

22

23.

On the Site System Roles, click Next.
On the Diagnostic and Usage Data screen, click Next.

On the Service Connection Point Setup screen, verify that “Yes, let’s get connected
(recommended)” is selected and click Next.

On the Settings Summary screen, click Next.

On the Prerequisite Check screen, make sure there are no errors and click Begin Install.

Click Close when the installation finishes.

Install

Core setup has completed

Elapsed time: 00:00:42:00

EF Insxalling poboy provider

&} Inctalling management point control manager
@} Seiting up management point

&k Instaliing boot image package

&k Canfiquring dats replication senvice

& Instaliing Configuration Manager console

¥} Creating program group

i\ Yau can closs the wizard now. Far a Ist of fasks 2 help you configure your sits; ses Bost-Seius Corfimurston fnsks
in the Configuration Mansger Dacumentation Library.

iew Log
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3 Configure SCCM

3.1 Configure Discovery Methods
1 Open the Configuration Manager Console from the start menu under Microsoft System
Center.

2 Select Administration in the lower left of the screen.
3 Expand Hierarchy Configuration.

4  Click Discovery Methods.

1y Mt

mom | Meme st

stn Descraton
i Active Diesctoey Fasest Discavery Disstled PO Canigures setungs that Confgaraion Henaper uses ta T Actve
~ Disabied P50 Cargures setangs thal Compunion Henager uses b bné grougs:
- Disatlad  PSD Canfigutis settingt hat Coofguraton Hisnapes Lt ta Tné comput
i~ Diatled P o s that Condguranca s userac,
* Erabld PO Canfigurea imberval for Cashurabion Yasager cheshs to pancdeally
™ Cisabled PO Carfigures sefings and paBing intervels b dstaver resources oo th

& ncuts and Complianca
& satware Ly

W Morironng

5 Double-click Active Directory Forest Discovery.

6 Enable Active Directory Forest Discovery.
Bl Active Directory Forest Discovery Properties [ =]

Garera |

'lé&' Acfive Directory Foreat Dlacaveny

Corfigure aettngs to find resources from Active Dircctary forests. When vou configure the
forsete to decover Actve Directory etes and subnete, Configuration Manager can awomaticslly
create bourdaries from this infomation

[¥] Enabie Active Directory Forest Discovery

| Automztcaly create Active Dirsctony ste boundznss when they are dizcoversd

~ Audomsticaly creste [P addess range boundares for I s_binets when they ae
dacovared

Schedule

Rur every: 1 o] |‘Wecka v

7 Enable All options, leave schedule alone, click Apply.

8 Click Yes when prompted to run full discovery and then click OK.
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9 Double-click Active Directory System Discovery.
-] Active Di Discovery Properties [

Gereral | Polng Schecude | Actgefliveciony Atrbutes | Dptions

.é, Active Drmctery Symem Discavery
Carfigure 7z a27ings tnd computer m Active Diectary Deman Seraces.

] Erahle Active Diactery System Diecavery Y\,dd

Actrve Directary cortaners

| Pt
Diatinguished Nare: Racurive Group Acoournt

There are noibems o show in tus view.

ok [ Cencel | [ Aomy

10 Enable Active Directory System Discovery.

11 Click Add. Select Browse and Select <YOUR_DOMAIN> and Click OK

[x]

Active Directory Container

Speciy an Achwe Directory cortainer fo seach duing the discovery process.

Lecation

Specty a ocation for the Active Direclony search. You can browee to 2 single containes and
erier an LOAF query o fnd an Acive Dimcicry cortansr wihin & paicuer daman. O, you

= emer 3 Glohal Cataleg (G quany e find 2n Antive Dirsctany erwihin muttiple
CorTaing .
Psth:

LDAP //DC=uchodl DS=iocal | Bowes..
Search Opions

Active Dyectary containers

Active Directory Discovery Account
p the soechiec location
The Active Directory Discovery Account must have Read pemission to the specified location

E B
1 Facuby () Use the computer account of the site server
_| Formigr SecurtyPrincipala

%7 LostindFound F - ®) Specify an account:
_| Manzged Service: Accourts

DS Custes B SCHOOL\SCCM.ADMIN
& Pregrom Dot ol 2 Garesl | set hd

i ] e

12 Select Specify an Account, Click Set, Click New Account. Browse and select
<YOUR_DOMAIN>\SCCM.Admin. Enter Password and click Verify -> Test Connection
and OK.

Windows User Account -

User name: [scHOOL\scem admn | [ Bowse. |

Example: Domain'\User

Password [eevaseaee |
Confim password: | |
Data source [Active Directory v]
Fath [LDAP.//DC=school DC-ocal | [ Bows. |

[ Test connection |
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13 Click Options, Check “Only discover computers that have logged on to a domainin a
given period of time” and “Only discover computers that have updated their computer
account password in a given period of time”

=] Active Directory System Discovery Properties .

| General | Poling Schedule I Active Directory Attributes | Options |

Configure options to exclude computers from discovery.

Only discover computers that have logged on to a domain in a given period of time

Time since last logon (days): 50 =

1, This option requires Active Directory domain functional level of Windows Server 2003 or
later.

Only discover computers that have updated their computer account password in a given
period of time

<>

Time since last password update (days): 50

14 Click Apply

15 Click Yes when prompted to run full discovery and then click OK.
16 Double-click Active Directory Group Discovery.

17 Click Enable Active Directory Group Discovery

18 Click Add > Location.

| Active Directory Group Discovery Properties -
General | Poling Scheduks | Ootige |

‘L_:, HAtive Dinectory Group Dscovery

Corfire seringsto dazeverthe Achve Drectory creup memberivp o compubers and Laers.

| Enabe Active Dr=ctory Goup Dacoveny

Discovery scopss:

[ram
Hamz Tyne Recursive Acoount
Schonl.Lacal Lozatian Tes SCHOOLASCCM...
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19 For the name enter the FQDN of your Active Directory Domain.

Add Active Directory Location B
Aotivs Directony Inoston

Enter the locaion by usrg & detrgushed nane (DN or an Adive Diectory forest, domain, comsner, or
organizatienal unt (DU Or, brwse 10 e oostion

. Wheriyou specfy an Adtree Desstcnplasation thir has 2 lge rusber o greps o g thet
heve many mambars. he d ke ak iah.

\\A |
N [seheal Lecal |
Location: Bample: LDAP /A Lserhccounts, DC<cortese, DCacom

~achial DC<acd | )

Select New Caniainer =
Active Disctery contanaa
pemon o the specfed loceion

20 Click browse and select the root of your Active Directory Domain.

21 Click OK.

Active Directory Group Discovery Account
The Active Directory Group Discovery Account must have Read pemission to the specified location.

() Usethe ste server’s computer account
(@) Specify an account:

SCHOOL\SCCM.ADMIN

[ ok |[ cace |

22 Select Specify an Account, Click Set, Click New Account. Browse and find

<YOUR_DOMAIN>\SCCM.Admin. Enter Password and click Verify, Test connection and
OK.

Windows User Account -

User name: [SCHODL'scem admin | [ Bows. |

Example: Domain' User

Password [eeeeceese |
Confim password: \......... ‘
Data source: [ Active Directory ¥]
Paih [LDAP-//DC=school.DCocal | [ Bowse.. |

[ Test connection |

23 Click Apply, Yes, and OK.

24 Perform Steps 9-15 for all remaining Active Directory discovery methods.

25 Ignore Network Discovery
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3.2 Configure Boundaries

1 The IP Subnet and Active Directory Sites should already be created in the Boundaries.

Verify that they do exist by going to Administration -> Hierarchy Configuration ->
Boundaries.

2 Now, Right-click Boundary Groups and select Create Boundary Group.

Administration € Bound

+ B} Overvew
4 ] Hierarchy Configuration
& Descovery Methads
|| Boundaries
[_:-E. Boundary Groune

5 Exchange § (8 Creste Boundary Group |

£ Addresses | |
4% Active Directory Forests

1 Site Configuration

& Ciert Settings

3 Enter respective name and click Add.

4 Select the respective AD Site and Subnets and click OK.
= Create Boundary Group [ =]
V Overview| | Genwral | Refrmons | =

) Nara Pihc S By G
Descnption:

Thes fokorwing boundanes ae menibes of this beurdary group.

Bourdams.

Far

Name: Descrption
Select beundianes o add o this baundary group.
Eoundanss.
Fiber
Boundary Description
[+ Dustrict - Admin ‘achool kocal/ Thstect-Adminy
O 192 168126 1192160126 258 achosl R 192,168 1
o High-5chedl achy +Sehool
W 192,168 135 1-192.168.135 254 o 4 ool/152 15813
¥ Bemertary achaol kcal/ Benentan
F 1921581491150, 168.14925¢  achoolbcal/Blenentan: 152 168 145

Add |
oK Concel | [ Fooy
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5 Click Apply and OK.

= Crente Boundany Group

| -
[ ham/
1] Ui bounchery graim for st ammgrerart

Tha asegrad s defuraras #1a Conlglor sie coopuler resciscs s ssmgratl b dumg dacovery. | ales

x|

Cartmt bzaten

‘Add Site Systerrs || S ——

Electthe st spatms 1o asazciste wih e by Fap

Sie spter

Seree e dte =
] ST A et locsl P50
o | [ ] [

6 Right click the newly created Boundary Group, click Properties, and go to the
References Tab of the boundary group. Select Use this boundary group for site
assignment and add the site server to the boundary group. Click Apply and Ok.

Configure Site Roles / Endpoint Protection
1 Select Administration in the lower left of the screen and expand Site Configuration.

2 Select Servers and Site System Roles.

P B & po
1 i St'ar! Proj

loan
LS|

Nane i Site Code Countofrales | Type
SCCM-A-1 schoollneal RS0 i . Primar
o Aol Site System Rohes
/‘ﬁa Start
(3 Pefrech Fs
75 Delete Difete
- Properties

Faph:
L DRl Servs
+ Tt
1 sites

[ Servers ard Site Systern Aoies

3 Right-click <YOUR_SCCM_SERVER> and click Add Site System Role.
4 On the General screen, click Next.

5 Onthe Proxy screen, click Next

6 On the System Role Selection screen

e Endpoint Protection roles, Click Ok on the pop-up
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e Click Next.

g’ Sipsbeen Rl Seleclion

General
Prowy
Application Catalog web Avzizhie roles

Application Catalog web: ] Apoiication Catalog web service pairt
Appli ls#] Aoclication Catabog weksite noinl

Endpoint

Specify roles for this seqver

L] Aeeet Intekganca eynchronization point
[ Cerrficats regetration poit

|w#] Encpaint Fratection ooint

[] Enroliment partt

(] Envoliment prosy poirt

[_] Falback et=tus point

[] Cax of bard service point

M| Feocrng servicsaport ]
[] Saftwars undane poirt

[] Seate: mogration poert

["] System Heatin Vaidatar poitt

Compiztion

7 On the Cloud Protection Service membership type screen, select Do not join Cloud
Protection Service and click Next.

Genesal

Proxy

Systern Role Selection
Application Catslog web

Specify Cloud Proteciion Sanica membership type

The Clewd ype ¥ el be 2ppled o o Endpoint Protecson antmaiwane policses, Cleud
Application Catzfog web:  Prtoctin Sanics (& 3 wordwids cnins conmrdy thal inch.cke Syetem Canter Enchsint Prutaciion e, By poving Ceud Prolection
Senice, System Center Endpourt Frotecoon wil wend Inic Ficrosoit to hel oft

Application Catalog Cust  nveatigibe fer okt vt ek el inpvava Syitem Conie Endpsirt Prtacton's aioctivarssaa. Thia commuty 3o halpe op
Endpoint Pratection Ahe spreed of new mebcous soltware riecions.

Y64 G20 ch00#8 10 1hs Coud Protection Sarv: th extr 3 B3ac O ha typ of
)2 ot in oot ta Microacht depands on your level of Cloud Preesction § bz, b f
gt urirtertionaly e serk 1o Wicmeol Howsver. Nicroedt wil ot use thie iformation fo dantfy you or o cortact you

To learn more about Basic ard Advanced Membarships and the information cellactad by the Reparts, sae the Privacy Swtement
at hip o macroach) e Fdink Lk D-E0E88T

@ Do ra pr Goud Fotection Sevice

(C) Basie membershp ion Wirdows 10 and sbove. wthe same

() Advarced nembeshp

8 On the Summary screen, click Next.

9 Click Close when the wizard is finished.

3.4 Configure Network Access Account
1 Select Administration in the lower left of the screen and expand Site Configuration.

2 Inthe left-hand pane, select Sites.
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3 Right-click the Primary Site, and click Configure Site Components -> Software

Distribution.

| Addrminictration a | Gt

tmn | mame ) Tyme Server Hame state Site Code
E PSD - Public School Dastnct  Pmery. SO0M-A-1schoolincl Actrve. psD
aries. B Add Stte Syshem Roles
ary IS P Comate She System Server

e Sarver Cannettort = i} Coeate Secondary St

B Addresses

A Active Dinsctory Forests
4 2 Site Canfiguration
g Ses

& Servers and Site System Rotes

Drirte et
e Cheri St |

Secy Mj Canfigire Ste Camponents v System Heslth Valdatnr
& DAstrtan Paings - & Client Instabation Settngs » suftware Distnbution

She M; Software Update Foint.
B osets s Complince Public School Distrig = == ansnense re e an
: Al st summerzers Wanagement Point
.‘ﬁ- Software Library General & Stahs Fiter Rules Status Reporting
BB Vonkoring Sie Code: § setsecuity Scupes BB oyt of Band Managemmt
SenpT e, Emd Hatification
Install Directony: 171 Properties

4  Select Network Access Account, click the Set button and set the
<YOUR_DOMAIN>\SCCM.Admin account and password.

= Software Distribution Component Properties [x]
Site C
Ganersl | Network Accest Accaurt /
nams
Sosciy s socourt thet sccesses nstwerk kiceters when the ste cortans cherts thet are
workrouo computens o that ae from an untrusted domain,
Na
P Netwerk Access Accout
The Network Access Accourt is used by Corfigurstion Manager dierts 1o sccess
rstwork locations during content dapioyment of during operating systam degloymant
_* Usethe computer accourt of the Configuration Manager clert
® Specky the sccourt that sccesses netio® locaons /
Usecname: SCHOOL\wccm.adenn Buwse. |
Exswgle: Doman\User
Pazsword cenvensen
Corfrmpassword. | eenee. eee
Vedy <<
Daxa source v
PNecwork share: Browse. |

5 Click Apply and Ok.

3.5 Configure Client Agent Installation Method

***please verify the client push manually before you select “Enable automatic site-wide client push

installation”

1 Select Administration in the lower left of the screen and expand Site Configuration.

2 Inthe left-hand pane, select Sites.
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3 Right-click the Primary Site, and click Client Installation Settings -> Client Push
Installation.

LE PSD - Publc School Distict  Primary (8- schonl local Artive, Fs0
L4 Add Site System Roles

M Create Sihe System Server
i Create Secandary Ske

Retry Secondary S2e

Configure Sits Components

T

v
Cllent Tnstallatin Settings v Clent Push Dnstaation
Public School District |

Site Hambenance Suftwere Update-Based Client [nstalfation

= L

Status Summanzers

4 Enable automatic site-wide client push installation.
B Client Push Installation Properties =

Ganeral | Accounts | indtalstion Freperies

\E Giert Fush intainta fer Garfgurton Manager chem
Ensbie sutomatic ste-wide chent push rstalstion

This option initafk thi Confipurston Manager chant on newty dacaversd compiner
Ll do ot he cherd inetallad.

Specky whether to ntall the Configuration Marager clert on demain cortrallers when you
use sle-wide chent push inslalation and the Clenl Push installstion Waand

miguration Marager chert on ook

& Mever el he Conligurgon Manager deen on donain comimier urieds ipechisd
= nthe Cherd Push Instafision Wizadd

oK Carcel

5 Check/Uncheck Servers and Configuration Manager site system servers if you
want/don’t want to push SCCM client to servers.

6 Select the Accounts tab, Click Add.

= Client Bush [nstaliation Properties L%

|| Gererel | Acturts | Instelaten Fropettes |

Specly the accoune Ihat can inetal the Confiourstion Manager cient. Tha acotnts must ba 3
member o fhe lozal Admrisimto g an the destenon comecrsr.

Har}
psg :
1| Clert Push busteltion accourts: X B8

Hame
Windows Lser Account X
Lar names |SCHOOL com 2dmin Browsa...
Exampls: Demain'Leer
Pl ernranes |

Corfimpaszwad, | wesssunss |

erdy =
Dtz s Nt Share -]
Plibworke shane Iml\el'SMS_PSD Emm

7 Enter <YOUR_DOMAIN>\SCCM.ADMIN and click OK.

8 Enter the account password, and click Verify.
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9 For the Network Share enter \\<YOUR_SCCM_SERVER>\SMS_PSD (PSD will be replaced
with your Site Code), and click the Test Connection button.

10 Click OK, and then Apply and OK.
3.6 Configure Client Agent Settings

3.6.1 Client Cache Settings
1 Select Administration in the lower left of the screen.

2 Inthe left-hand pane, select Client Settings.

w

In the right-hand pane, double-click on Default Settings.
4 Select Client Cache Settings.

5 Select the drop down next to Configure Client Cache Size
6 Select Yes, leave everything else default

Background Inzelligent Transfer

|[tient echie Settings

Default Settings

Client Plicy 9= Speciy sefings thet apoly to l cierts it the Herarchy. and can be modfied by cusom selings
Cloud Services

Compliance S=ttings
: Spectfy chant cachs eattings and whather cients c=n obtan coment from a peer.
Computer Agent The cisrt cache size can expand to the madinum 2e in MB orthe percertage of the dek, whichever is lses.

Computer Restart
Device Setlings
Endpaint Protection p—t
4 Configure BranchCache Mo
Enrzliment [
Hardware Inventary Erahle BanoCache
Mazximum BranchCache cache 226 peicentage
of cisk)

IMeszrad Internet Connsctions

Power Management

Softwears Inventory

Corfigure ciert ceche aze Yes ~
Remots Tools =

Mazamum cache eizs (MEB) 5120 s
Softwars Desloyment

Marimum cache siz= {permemage of disk) 20 =

Erable Corfigurtion Menager et inful OSto [y

Softwears Metering shara contant
Software Updates Pont for intial natwork broadcas:
State Messzging Erahle HTTPS for ciert pesr commurication

User and Device Affiniky Podt For cotert dowiond Fruiii pest

HTTFHTTPS)

3.6.2 Computer Agent
1 Select Administration in the lower left of the screen.

2 Inthe left-hand pane, select Client Settings.

w

In the right-hand pane, double-click on Default Settings.
4 Select Computer Agent.
5 Enter the Organization Name to be displayed in Software Center

3.6.3 Endpoint Protection
1 Select Administration in the lower left of the screen.

2 Inthe left-hand pane, click Client Settings.
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3 Inthe right-hand pane, double-click on Default Settings

4 In the left-hand pane, select Endpoint Protection.

Backgrourd Intelligent Transfer

Default Seftings
Cloud Senices

Cliestt Policy 9= | Sneciy setigs ihat appky 12 o cheris nhe hierarchy, and can be medfied by casion selings.
Campliance Settings

Camputer Agent
Salect whethar 1o manags ewxieting Endpoint Prolection cianta o7ta inetal Erdooint Pratection on clants.

Camputer Restar

Endpoint Frotectian || paviea Senings )

Harduware bweriony 7= | Merage Ercpont Protection dliert on cherd | — v| ——
o compters
Metered Internat Connechions bt
Ineall Endooire. Frotecion chent on chert. | Ten v| ——
Enrallmert e
Mitwnrk Arcess Pratection (RAP) "L:_U'\’"C* remaie meously melabed |‘.'§a< >
arim

Piwer Management

Remote Tools

Softwere Deployment

Software Inventony

Embedded devices
Softveare Metering s, amnt Endiard ot hert
instalionfenuies rmsiats)
5
Saftymre pcates Siuppress any recued camputer st aher [ v
the Endooirt Frotection chent i5 rataled
Blwed period o fime ures c2n posipone 2
recuied restar o complete the Endpert
5

State Mezsaging

User and Deace Afinity

Diszble zbemate sources (such 2a Wiomaoft
Windows Lbcebe. Momecht Windows Sermr
Update Sendces, or LINC shams) farthe intis

aK Cancel

5 Adjust the following device settings as listed:
e Manage Endpoint Protection client on client computers: Yes

o Install Endpoint Protection client on client computers: Yes

3.6.4 Remote Tool
1 Select Administration in the lower left of the screen

2 Inthe Left-hand pane, select Client Settings.

w

In the right-hand pane, double-Click on the Default Settings
4  Select Remote Tools

5 Click Configure
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6 Select Enable Remote Control on client computers for Domain and Private

Detault Sestingt =)

regathn sy o cherta e b s cambe redel i caten st Re Contatand s i | Client settings l

| Enable Femols Cortrol on chert computess.

Spechy rerete et selirgnen et e

¥ aik fpentd ters

e ensune thet thes connection i net blocked by Windows Fremval an the destrasion comouter
ket orva o mors of the Trewal proties lo automaticaly configurs the Rencis Contrel ot and
g megions for cherts,

¥ Donan
This Windows Frewal profils is for computens that leg on bo 2 Windows daman:

] Pmvate
This Wiestaws Frewasl profle i for computess thal conniect 10 a privete netwark lacation
mch 9.0 home o ofom retwork

| Fubhz
Thia Whindowa il profile & for comptors that eonract ta = pubic nstwor lozstion

=

7 Adjust the following device settings as listed:
Allow Remote Control of an unattended computer: Yes
Prompt User for Remote Control permission: Yes/No — (Administration’s choice)
Grant Remote Control permission to local Administrators group: Yes
Show session notification icon on taskbar: Yes/No — (Administration’s choice)
Show session connection bar: Yes/No — (Administration’s choice)
Play a sound on client: No sound
Manage Remote Desktop settings: Yes
Allow permitted viewers to connect by using Remote Desktop connection: Yes

Require network level authentication on computers that run Windows Vista system
operating system and later versions: No

8 Click OK to accept the settings.

3.7 Configure Site Deployment Verification

1 Select Administration in the lower left of the screen
2 Drop down the Site Configuration folder on the left side
3 Select Sites

4 Inthe right hand side of SCCM select your primary site: i.e. PSD — Public School District
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5 Rightclick your primary site and select IR i 5o s s ;

P ro pe rti es Deployment Vericathn - Seerty | S0rg and Eroyption  Servica Windows
e creatod 3t ts ske fn

Corfigur datats for colnci haipto oloymarts th
exarple of 8 Ngh ek CEpayTent 13 3 fes Sequence wiil  pumcas of Aecumc thal depidys an operaing
e

6 Select the Deployment Verification tab Fighsick: deloymante 21y alivays lmtod 10 clstom collsctions sndine st AllUnkincwn Compisors
Colbection sze imits.

Corfigure tva mamum size of the custam oollsctions that yoru £an selsct 1 the Selact Colechon window.
(Specty 010 dissbie 3 configuration)

7 In the Collection Size Limits box put a 0 in Gy St St bt seconcs o ceft e

Detast aon o 3
both boxes e e L T e
Mmarum sas o 2

Coltectiora wiih ate systom tervem:

Specity tha behavier 10 13ka whin 1hé Yelctod colacion NALGe: Computans that hea Conligurabon
Marager ate system rches

8 Inthe Collections with site system server

) Block: g0 net creste the Ceployment

box, select Warn, require verification

(@) Wam; moum velication bafors cresting the deploymant

before creating the deployment

0K Cancal Seoly

3.8 Enable PXE support
1 Inthe SCCM Console, click on Administration -> Distribution Points

2 Right click your Distribution Point in the right side of SCCM and select Properties.

3 Select the PXE tab and place a checkmark in Enable PXE support for Clients. Click on
Yes when prompted about firewall ports.

4 Enable all options.
5 Set the Require a password when computers use PXE.
6 Set User Device Affinity option to Allow User Device Affinity with Automatic Approval.

7 Set Specify the PXE server response delay (seconds) to 5

PXE | Muticast | Group Relationships | Content [ Content Vaiidation | Boundary Groups

o Enable PXE support for clierts
Windows Deployment Services willbe installed f required

Allow this distribution point to respond to incoming PXE requests
Enable unknown computer support

Require a password when computers use PXE

Password: [ I
5

Corfim password [ I

User devic ity Do not use user device affinty v]
Do not se user devics affniy
AT e N 2 Network interfaces Alow user device affinity with manual approval
O e e A T TRk (s low user devics sffinity with automatic sppraval
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8 When this Role has finished installing, you will find the directory S:\Remotelnstall.
Please verify that inside that directory you have an smsboot\x86 and smsboot\x64 with
content. If the folders are empty, please wait before continuing to the next section.

3.8.1 DHCP Settings for PXE

NOTE: The following is now necessary for the clients to choose if they are UEFI or BIOS.
Defining DHCP Vendor Classes:

The first thing to do is to define the vendor classes for the BIOS PXE Client x84 and x64 and the
UEFI PXEClient x86 and x64. To do this:
1. Go to DHCP, right-click on IPv4, click Define Vendor Classes.
2. In the DHCP Vendor Classes window, click Add.
3. For the Name enter PXEClient (UEFI x86).
4. For the Description enter PXEClient:Arch:00006.
5. Click in the ASCII column and type the text PXEClient:Arch:00006 (you will not be able
to paste this text, and it’s also case-sensitive).
6. Click OK to add it to the list.
7. Now repeat steps 2 — 6 for PXEClient (UEFI x64) with PXEClient:Arch:00007 as the
Description and ASCII value.
8. Finally, repeat steps 2 — 6 for PXEClient (BIOS x86 & x64) with PXEClient:Arch:00000
(five zero’s) as the Description and ASCII value.
You should now have three additional vendor classes.

“ Home Share View

61 il || E:\Remotelnstall\ SMSBootix6d
A Favorites Mame - Date medified
B Desktop [ abortpxe.com
4 Downloads | bootmgfw.efi
1=l Recent places == bootmgr.exe

[ preboot.com

18| This PC || preboot.n12
m Desktop | wdsmgfw.efi
| Documents == wdsnbp.com



DHCP Vendor Classes _
Available classes:
Name [ Description I Add...
Microsoft Windows 2000 Options Microsoft vendor-specific option...
Microsoft Windows 98 Options Microsoft vendor-specific option... Edi...
Microsoft Options Microsoft vendor-specific option...
PXEClient (UEFI x86) PXEClient:Arch:00006 Remove

£ EFIx64)

Creating the DHCP Policies:

Now we’re going to create policies in DHCP so that the correct files are served to the correct
clients. You will need to do this for each DHCP scope that you will PXE on.

. Go to DHCP Console and expand the scope you wish to create a policy for.

. Right-click on Policies and choose New Policy.

. Enter PXEClient (UEFI x64) for the name.

. Enter a Description if you want. Click Next.

. On the Configure Conditions for the policy screen, click Add.

. In the Add/Edit Condition window, click the Value: drop down menu.

. Choose the PXEClient (UEFI x64) vendor class you created earlier.

. Check the Append wildcard(*) check box and then click Add and finally OK.

. Click Next on the Configure Conditions for the policy screen.

10. On the Configure settings for the policy screen, click No for the Do you want to
configure an IP address range for the policy. Click Next.

11. On the Configure settings for the policy screen, scroll down until you see options 066
and 067.

13. Check option 066 and enter <IP-Number-of-SCCM-PXE-Server>.

14. Check option 067 and enter boot\x64\wdsmgfw.efi — this is the x64 UEFI boot file
for SCCM. Click Next.

15. On the Summary screen, if all the details are correct, click Finish.

16. Now repeat steps 2 — 15 for PXEClient (UEFI x86) with boot\x86\wdsmgfw.efi as
option 067.

17. Finally, repeat steps 2 — 15 once again for PXEClient (BIOS x86 & x64) with
boot\x64\wdsnbp.com as option 067.

OO0 NOOULLDE WN

4 Collections

4.1 Creating Device Collection
1 Inthe Configuration Manager console, click Assets and Compliance.
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In the Assets and Compliance workspace
Device Collection.
[ -

Folder

, Right click Device Collections and Select Create

e Create Device Collection Wizard L
- .
el b Y rt
'V, ¥ Ve g_ﬂ G
Create Device _Import Saved
Collection  Collections Searches =
e = Specify datails for this collection
— 54 Membership Rules
& v | & \ » Assetsand Compliance » Qvenview »  Device Collections Summary.
fftgics Nae. [Windows Inage
Assets and Compliance < Device Collections 4 items Completion Cor
omment
4 B Overview | Search ==
= Select Collection -
L Users lcon Name =
i & AUDeskiop and Server Clients [Dovice Catetions [t TR
pl ) = Reat Name Member Col
# User Collections & All Mabile Devices & Al Desktop and Server Clents
F i -]

A Device Collectior Al Systems
| & Create Device Collection
W Import Collections

L, User State Migr Il Unknown Computers

| Asset Intelligeng|

= |
Bl soltwae Mty | 2T b

. Compliance Settings ‘ ‘

N

_ Endpoint Protection
P Assets and Compliance

{5 software Library

>

& All Mobile Devices
L4 Al Systems
& Al Unknown Computers

| 10 [(hor=. ]

Cancel

3 Onthe General page of the Create Device Collection Wizard, specify the following information:

3.a Name: Windows Imaging Collection.

3.b Limiting collection: Click Browse and select All Systems.

4  Onthe Membership Rules page of the Create Device Collection Wizard, Click Add Rule, select
Include Collections. Select All Unknown Computers and click OK.

4.1.1

gg Membership Rules

Genersl Define membership rules {or this collection

Membership Rizles

Summarny

Protyess i dirithe colection when 1 updates. Yau
Completian nr"hs'al‘tl nuzato ndd a specic obisct ora wta‘ cbircts from 2 query. The colechon

ms'ma'dw can sho inchids or awdute ather colactons. Mambarshin nilas can 2dd orly thase.
ebiecta that s mambar of the fmling cellection

Mersberehip niss:
Fuie Name Tiee Calection la
Al Urkrawn Corpeters ke SMSO0IUS
71 \\ W r =
Acd Fuie - At
L Usaircrmmertal updates for thia Direct Auls
Anncremerts updste petodicn Duery Rule Selds rescurmes thint qusify

tothes colection This opten doef Hate forthis callaction.

Inclyde Coflections

Eclude Tollections

-Select Collections: =
| Device Cotiectiara | [ e
[ ] Roat Hame Member

[WE 4 Decktop and SorverCberts |
L1 &% 41 Wobvie Dewtces

| € 4 Systems

[ & A Uriknow Competars

Next and Complete the wizard to create the new collection. The new collection is displayed in
the Device Collections node of the Assets and Compliance workspace.

To configure a query rule

In the Configuration Manager console, click Assets and Compliance.

In the Assets and Compliance workspace, Right click Device Collections and Select Create

Device Collection.
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On the General page of the Create Device Collection Wizard, specify the following information:

3.a Name: All District Servers.

3.b Limiting collection: Click Browse to select All Desktop and Server Clients.

| Geneal | Specify details for this collection
Membership Rules
Summany
Pragress Mare: [0 Ditrct] Servers |
Campletion

|41 Domain Membar server and Domain Contrallars

Salect 3 collecton £ Lta a3 3 lmiting collsction. Tha imiing collection astablishes the resourcas
shat you can add to this colection by Lsng membaship niss

Liming cofiection: Al Deakiop and Server Jernta Browre...

La=t updatn
Thee codlaction has not besn updated yel

Lest merrbershio change
The collection hiss ot besr upceed yet

4 On the Membership Rules page of the Create Device Collection Wizard, specify the following
information:

General Define membership rules for this collection
Membership Rules
Summary
Progress Membership nules detemine the resources that are included in the collection when it updates. You
c et can use membership rules to add a specific object or a set of objects from a query. The collection
SIpeRan membership can also include or exclude other collections. Membership rules can add only those
objects that are members of the limiting collection.
Membership rules:
Rule Name

Type Collection Id
There are no items to show in this view.

Add Rule v
[ Use incremental updates for this Direct Rule
An incremental update periodicall C__Query Rule dds resources that qu
tothis collection. This option doel  Tnelude Collections e for this collection.

Exclude Collections
[V} Schedule a full update on this collection
Ocours every 7 days effective 8/20/2014 8:58 AM
In the Query Rule Properties dialog box, specify the following information:

1.a Name: Server

1.b Resource class: System Resource
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4.a Click Edit Query Statement -> Criteria tab ->

Click th

e Add Star

Defing

Member
can s

rambad

=]

Query Rule Properties

Ganaral

}_:J Name:

|Se¢\rers |

[ moor Guew Statemen... |

Reacurce clase: | System Resource

| Edit Guery Staiement ..

Criteria:

General | Creeia | Joins |

I
Query Statement Properties
specify oritera to namow the queny and limit the resuts that are

35611 7< [ e

1.b.i
1.b.ii

1.b.iii

Gl |

Attribute Class: System Resource
Alias as: <No Allias>

Attribute: System OU Name and click OK

==

Criterion Properties

“ )
i) P

Crteron Type: Smele vahie

Where:

—p|

Arrbude cleas:

Alaz e

Attrbide

Select Aftribute

Systerm Flesauce =
“|

et OU e >

EZEES

EIE=

afing

General |

J‘LI Critecn Froperes

Crteson Type [ S vatue v

Whwre: [Ermem Fesouree - System OU Neme
]

Operator; v|

Value:

[ salis

SCHOOL LOCAL/DOMAIN
5 L/DOMAIN

SCHOCL LOCAL/DOMAIN CONTROLLERS

On Criterion Properties Click Value and Select <YOUR_DOMAIN>/Domain Controllers.

Repeat these steps in the same rule but select <YOUR_DOMAIN>/DOMAIN SERVERS in the last

step

Click OK to close the Query Statement Properties dialog box

Click OK to close the Query Rule Properties box

Click Next -> Next -> Close to finish the query rule.
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4.1.2 To configure a direct rule
1 Inthe Configuration Manager console, click Assets and Compliance.

2 Inthe Assets and Compliance workspace, Right click Device Collections and Select Create
Device Collection.

3 Onthe General page of the Create Device Collection Wizard, fill in the corresponding
information

4  On the Membership Rules page of the Create Device Collection Wizard, select Add Rule ->
Direct Rule

5 On the Search for Resources page of the Create Direct Membership Rule Wizard, specify the
following information:

1.a Resource class: In the list, select the type of resource you want to search for and
add to the collection. Select from System Resource values to search for inventory
data returned from client computers or select Unknown Computer to search for
values returned by unknown computers.

1.b Attribute name: In the list, select the attribute associated with the selected
resource class that you want to search for. For example, if you want to select
computers by their NetBIOS name, select System Resource in the Resource class list
and NetBIOS name in the Attribute name list.

1.c Exclude resources marked as obsolete — If a client computer is marked as obsolete,
do not include this value in the search results.

1.d Exclude resources that do not have the Configuration Manager client installed — If
the search results include a resource that does not have a Configuration Manager
client installed, this value will not be displayed in the search results.

1.e Value: Enter a value for which you want to search the selected attribute name. You
can use the percent character % as a wildcard. For example, if you wanted to search
for computers that have a NetBIOS name beginning with ‘M’, enter M% in this field.

2 On the Select Resources page of the Create Direct Membership Rule Wizard, select the
resources that you want to add to the collection in the Resources list, and then click Next.

3 Complete the Create Direct Membership Rule Wizard.
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4.2 Set Collection Variables for Imaging

1 Right Click All Unknown Computers, Select Properties.

Baxuts and Compise  Du

Limiting Cellecaon

A Systern

# B Cva
& sers kon  Meme
8 Dy & A Desktap and Senee Chents
e Uer Collecticns & AnMobile Deviey
& Davse Coternons & arsuens /
Ay liser Stmte Wigration g A8 Unknaven Corprters

Asset eefligence s Inage
1 Lotruare Matmnng
| Comphance Setiings

Endpeint Probecton

Al Unknown Computers
B oty and Comphance

Sumenary

4 Sottware Library

B wonnoneq

7| Adminirstion

* Show Members
e 2dd Selectad Hewe
ok et
B Manacs Aty Raquar
B3 ptanage Qut of Bang
3} Cear Remmiires 7 Deployments

T Updat Membershi

e Dimet Waificstian

Kl Enapoint Pratecnan

#* Esport

Lo Cony

4 Refrssh ]

Al Unkee = B
O Sewsiate Deploymant
2014

2 Select Collection Variables Tab, Click the add Star

3

=] All Unknown Computers Properties

=]

Gereral | Membamhp Rues | Power | D

| Martenancs VWndows

Colecton Verables. | Oue of Eand Marnagement | Diembution Point Groups | Seeuty | Asts

Specty custam task seou: anablea with associated valuse that you want computens to use
n the colection. Tazk esquence vanzhlee nouds este of namee and vafus pain that supoly
configuration and operzting sydem depoyment settings for a device, operating system, and user
state carfigumiion fasks on = Carfigumtion Marager chent compiter You con use tass
seguence vanzhles to corfigure and customize the st=ps in a taek seguanca.

\anables:

B

<Neves Variable
Diefine the vaisile a+d ils sssocialed vabe
HNeme: |05 DComp.tertiame
Nl Specity the valoe and the volus aetings.
3_ Dio nat diplay this vale in the Configuration Manager console

Value:

Corfrm vale:

O Cancel

Enter Name: OSDComputerName, and uncheck “Do not display the value in the
Configuration Manager Console”. Click Ok, Apply and Ok to close the Properties Window.
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5 Software Deployment

5.1 Software Distribution Share
1 OntheS: Drive, create a folder called Software Distribution, right click and select
Properties.

2 Click on Sharing tab, Advanced Sharing and share this folder out with the following
settings:

3.a.i Share name: SDS$ - ($ is used to make the share hidden).
3.a.ii Caching: No files or programs from the shared folder are available offline
3.a.iii Permissions: Add the following permissions for the share:

- Domain Admins: Full Control

SCCM Admins: Full Control

- SCCM Servers: Full Control

- SYSTEM: Full Control

- Authenticated Users: Change and Read

- Local Administrators Group: Full Control

- When done click Apply -> OK -> Apply again -> Ok again

3 Click on Security tab -> Advanced -> Change Permissions -> Disable Inheritance. On the
pop-up click Remove all inherited permissions from this object and then Apply and OK
to get back to the Security settings.

4  Click on Edit and then add the following groups:
- Administrators: Full Control
- Domain Admins: Full Control
- SCCM Admins: Full Control
- SCCM Servers: Full Control
- SYSTEM: Full Control
- Authenticated Users: Read & execute, List Folder Contents and Read

- When done click Apply, Ok and Close to finish.
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5 Inthe Software Distribution folder, create folders called Images, Drivers and Software.

5.2 Software Package
5.2.1 Create Software Package

5.2.1.1 JAVA (EXE INSTALL)

1 Inthe Configuration Manager console, click Software Library.
2 Inthe Software Library workspace, expand Application Management, and then right click
Packages. Click Create Package.

* Pac ems

Sottware Li

4 A Overpew

4 [} Applicaton Mansgement lenn ma
|5} Apphcations o] Configuiation |
Pikores /
2 T q Creste Package

s |6
[ create Package from Defininon

¥ Imeort

Faldzr 3

B fsects and Compliance
(51 Software Library

B Monitoring

<1 Administration
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3 Onthe Package page of the Create Package and Program Wizard, specify the following
information:

Specify information about this package

Ertara nane and cther dstalz forthe rew package, Totzke i hy
Boplieation Calaleg, uas an appicalin rstaed

Manufactuern

[ This packege cortars souce fes

Set Source Folder =] TR
Specty the location of the sourss fies for s package. The sie server
campyder atecLrt must be tie 1 2ecesstne soures feider
Saurce faldec loostion.

#) Netyork: pasth (1M rame]
| Local fielder on ste sener

Name: Jre-8u333-windows-i586.exe

Check This package conatins source files

Source Folder: Network path (UNC name)
\\<YOUR_SCCM_SERVER>\sd$\software\JRE8u333-exe

4  Onthe Program Type page of the Create Package and Program Wizard, select the type of
program you want to create and then click Next. You can create a program for a computer, a
device or skip this step and create a program later.

Package Choose the program lype thal you want to create
@ Standand progren
Creste a prgmm for a client camputer

) Program for dawice

Create a program for & devnce

5 Onthe Program Type page of the Create Package and Program Wizard, select Standard
Program, and then click Next.
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%g Standard Pregram

Fackage Specify information about this standard program
Frogram Type
Standard Program
Requirerments Hame: |Java -JRE1.8.0_25 exe ingal |
ey Command ire: [ire-tu25 indows 586 ece /= /an * EXPLORER=1 MOZILLA=T | Browse
Frogrese
Startup folder: | |
Completon
Fur. [icden “|
Program car rr: |\-"a’hetl'e-' or ot & Lseris lagged on v |
Run mads Fun with admirigtrative ighta

[T] Mlew users fo view and interact with the progrem installation

Drive mode: | Runs with LINC nama w |

On the Standard Program page of the Wizard, specify the following information.
Name: Jre-8u333-windows-i586.exe install

Command line: jre-8u333-windows-i586.exe /s /qn " IEXPLORER=1 MOZILLA=1
REBOOT=Suppress JAVAUPDATE=0 WEBSTARTICON=0"

Run: Hidden
Program can run: Only When a user is logged on

6 On the Requirements page of the Create Package and Program Wizard, set maximum
allowed run time (minutes): 15

Fackiye Specify the requirements for fhis standard program
Pragrarn Type
Standaed Program
[T R i
Summary
Fragress

Campletion

Platiom requremems
# Thes pragram can nn on amy pizthorm
) Thia prorem c2n i oy on smeced pisforma
IWE T

Estimate cisk apacs: [Ckrco] w |[MB_

Maium ehowed e fnrudes], [ vl

7 Click Next and finish the wizard.
5.2.2 Distribute Software Package

1 Right Click Adobe Reader, Select Distribute Content

Tcon Name Progra
Adobe Rpader =
Configur a‘p Manage Access Accounts

|| Create Prestage Content File

(7] Create Program

/¥ Export

T4 Refresh F5

75 Delete Delete

E»  Deploy

S~ Distribute Content
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2 Onthe Conten

t Destination screen Click Add and Chose Distribution Point and Select the

\\<YOUR_SCM_SERVER>.<YOUR_DOMAIN>.local and click OK and Next and Finish the

Wizard.

g! Content Destinstion

Generst
Surmmary
Frogress

Completion

Specify the content destination

-Add Distribution Poinits
Coreem wil be dimrbured o g datrib pores. catry Gefect detibution ports that wil host this centert.
dsmbutian okt gmups thar are ey assocated weh colecions

Scltware Updabe Fackages ane never deinbubed to Cloud Chetribuson Pores.
Contan destiralion

o 7 i Fusiable dsinbutin points:
—e |Fasr..
Name Desanplion emocdians Collections = =
: et - : Y- oo Diescnction
There are no s be show in lhis wew. S Distribution Pointl| | 5 serm A1 SCHODL LOCAL Qnpreniees

[ Distribution Point

=]

5.2.3 Deploy Software Package - Required

1 Right Click your Package and Select Deploy

2 Onthe General page of the Deploy Software Wizard, specify the following information:
Software — Displays the application you want to deploy. You can click Browse to select a

different appli
Collection —Cl

g; General

Content
Deployenent Settings

cation to deploy.
ick Browse to select the collection you want to deploy the application to.

Specify general information for this deployment

Schedubing E
e e Saftvar |20 - RET 8025 8we fiown -JRET B0 25eweirtal) W | Browse
Calaciin |4l Degaop and Server Clents [—

|Dams Colecliors d | | Fitar . 5

. Rt Hama Mambar Court.

i Do an Senvar Clsoin 0

& Ml Mabte Dovises [

& Al Syders 3

& Al Lirknown Campuers z

3 Onthe Content page Click Next

General
Content
Scheduling
User Experisnice
Distibution Points
Summary
Frogress

Completion
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inst=llation deadine, which might incur additional cosis



4 On the Deployment Settings page, Chose the Action: Install and the Purpose: Required.

General

Content

Spacify the schadula for this deploymant

Deployrment Settings

Uses E

This program wil be svalable 25 5000 2 & has been disinbuted bo the coment servems uniess Lis 5o

|terfime betow. Forrequined epplicafions, speciy the amigrment schedue.

periEnce

Distribution Points

Completion

nary

FHIE

L] Schedubs when this deplmyman wil becoms avalabla

Asvicrment scheculs: )

[ Scheduls when his daploymeant wh expire:

/

Hes

Assignment Schedule
) Aesign o the foliowing schedue.

Ocure.on B02014 554 AN

@) Assin mmed el afer this svert:

ik mnspmhb‘ v.
Ax oo a5 i“‘ﬁ -

of
Log S—

7| Caes

itema %0 sha

fevious

General
Content
Deplaymant Settings

User Experience
Deuiution Fonk:

Summary

Pragress

Corpiean

Specify the schedula for this deployment

T peograns while il atis
et bedaw. Fox et appiicaions, spsoly the ausgnTet schediie

Scheckde when the depiogment wil become avalabie
- - |[EEm |
(] Sohwchbe wihen this deplopment wll eapin

faagremert heshe e

5 On the Scheduling page, Select New and Assign immediately after this event: Log On.
Change the Rerun Behavior to Always rerun program. Click OK and Click Next to finish out
the wizard. This policy will take a few reboots to take effect. Because we marked this
Package as a “Required” deployment, you will NOT see it in the Software Center. You will

have to check the log files to verify it worked.
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5.2.4 Deploy Software Package - Available

1 Right Click your Package and Select Deploy

2 Onthe General page of the Deploy Software Wizard, specify the following information:
Software — Displays the application you want to deploy. You can click Browse to select a
different application to deploy.

Collection — Click Browse to select the collection you want to deploy the application to.

Speoify general information for this deploamant

Software. Rearm Cfice Actrvacion 3PP Reami}

‘Select Collection

3 Onthe Content page Click Next

—
«:é! Deployrment Settings

beneel Specily seltings lo control how this soflware is deployed
Centent

ployment Settings
Scheduling

Aion nsal

User Experience

Distribution Points Pupose: Avalasie v

Summary
Progress

Cempleton

4 On the Deployment Settings page, Chose the Action: Install and the Purpose: Available.
Click Next through the rest of the wizard.

5.3 Software Application

5.3.1 Adobe Reader
1 Download The Latest Version <AdbeRdr11007_en_US.exe> from Adobe - Adobe Reader
download - http://get.adobe.com/reader/enterprise/

2 Extract the contents of .exe using the following command <File_Download_Loca-
tion>\AcroRdrDC2200120117_en_US.exe -nos_o C:\AdobeReader -nos_ne

Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you

Cpen: | 1007_en_US.exe -nos_oC)\ AdobeReader1l -nos_ne w |

3 Copy the files from the above folder C:\AdobeReader to a folder in your Software Distribu-
tion. \\<YOUR_SCCM_SERVER>\sdS$\software\AcrobatReader and Create Application.

50| Page
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4 In the Configuration Manager console, click Software Library

5 Inthe Software Library workspace, expand Application Management, and then right click
Applications. Click Create Application

6 Onthe General Page, Specify Type Windows Installer (*.msi file).
In Locations put \\<YOUR_SCCM_SERVER>\sd$\software\AdobeReader\AcroRead.msi,
and click Next. Click Next on the Important Information.

| Geneeal ] Specify settings for this application
Import Information
Summary
Progrese Aoplications contain software that you can deplby to usera and devices in your Configuraton Manager envircnment

Completion Applications can cortain mutiple deployment types that customize the installation behavicr of the application

@ Automatically detect nformaton about this application from nstallation files

Type | Windows netatier (~mei fiie) |

Location ‘ \\sccm-a-1\sdS\Software\AdobeReader1 1 7\AcroFead ms ] I Browse
Eommnla AL Qo Shumm\ Bl

7 Enter the Information on the General Information Screen, Check Run installation program
as 32-bit process on 64-bit clients and Click Next and Finish the Wizard.

General Specify information about this application
Import Information
General Information
Surmmany Name
Progress Admiristrator comments:
Caompletion
Publighear:

Dptional referenoe:

|
Software version: |
|

Administrative categones: - | 5 Solect s,
Specify the installation program for this application and the required installstion rights
Installation program |mslsxec.f| 'Ac.m Heﬁc_l msl' r”q | | Browse. |

8 Click the Adobe Reader Application. At the bottom of the page click the Deployment Types
Tab. Right Click the Adobe Reader — Windows Installer, Click Properties

lcan Flarme

Adabe Feade: %) (11.0.07)
tova B Update 11 ‘\\

Adobe Reader X1 (11L.0.07)
lean Pricrity | Mama Dapan
[ ' Adope Beader XLi1LOOT) » Windows Instalie.. . MNo

B Asscts and Complionce

- 3 Update Content
S0 Softwars Libracy -
P --
Bl M onitoring
[Z]f, Metrministration
~ [Emmar] o Typw o
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9 Under the User Experience set Maximum allowed run time (minutes): 15. Click Ok and Apply

| Gerero! [ Cortert | Frogams | Detecion Mathod | User Exowiencs | fecuremerts | Rekm Codos | Dependenes |

Speciy user expensnce settings for the 2ppicabon

raalaton behavior Ingtal for system v
Logon requrenent Vihthar ok & uoer s logged on v
rstalston oogam visbilty. Hidden v

Spacsy the maamun run $me and estmated instaliation tme of the deploymert program for this apcteaten. The
egtmatad ngtala0n e depiays 1 he user whan The Jppicaton ratals

Nasmun showed run time fnnutes) L] 3 *

Estmarad rtalation time prirutae) 0 s

Shacdd Contiguration Marager erforos madhic behavier regandess of the appkcation’s rtended bahavior?

| Detemine beravier based on reem coces v

10 Under the Detection Method Tab, Click Add Clause. Change Setting Type: Windows Installer.
Prodect code, Click Browse to find the AcroRead.msi. Select The MSI product code must exist
on the target system and the following condition must be meet to indicate the presence of the
application. Change the Operator: Greater than or equal to. Leave the default Value.

=] Adobe Reader Xl - Windows Installer (*.msi file) Properties ILI

| General I Cortent | Frograms | Detection Method | User Experience | Requirements I Retum Codes I Dependencies |

Specify how Configuration Manager detemmines whether this deployment type is already present on a device. This
detection occurs before the content is installed or when software inventory data is collected.

(@) Configure rules to detect the presence of this deployment type:

e [ ome =
| MS! Product Code: {AC7EBAS6-7AD7-1033.7844- .| |
|

3

Create a ile that indicates the presence of this application.

Setting Type: | Windows Installer v

Specify an MS| product code as the basis for this ule.

Product code: |{ﬁCTSBﬁSG—?AD?—1D33—TB¢-!—ABﬂfEﬂﬂDD'D'D1}D1} 6 ... |
s . i = C
(_) Thig M5| product code must exist on the target system to indicate prg
@ This M5! product code must exist on the target system and the follow 5 v o |- = Softw... » AdobeRenderl,
4 this application;
Organize v N lder
MS] Property: |Ver5ion

\\‘ : # Videos Name
Operator: |Greaterthan or equal to i Local Disk (C)

i3 AcroRead.msi
a MS50L Database

| Value: 11007 T _|
11 Click Ok and Apply.

52|Page



5.3.2 Chrome

1 Inthe Configuration Manager console, click Software Library

2 Inthe Software Library workspace, expand Application Management, and then right click
Applications. Click Create Application

Sottware Library oA

= ff:C'verview
4 || Application Management in
[a=l Anpiicatic-nl'

[ Packages | &7 Create Apglication

[& approval RY W Impert Application

[ Gloka! Con|

| Folder v
_| Software Uptues— =

Operating Systems

F."' MAssets and Complianca

rfdﬁ] Software Library

3 On the General Page, Specify Type Windows Installer (.msi file). In Locations put

\\<YOUR_SCCM_SERVER>\sd$\software\GoogleChrome\GoogleChromeStandaloneEnterp
rise.msi

4 Click Next.
'zég General

R — Specify settings for this appiication

Import I rformation

Summary
Progress Appicatons cantain aofwara that you can deployt i your G Managar ar
Complenon Appicaons o i iy types that custamze the instelaton behavior of the sppication

® Automeficaly debect rommstion sha this spplcstion fom instalstion fies

Type: Winciorwes bisialier (" rsi fie) v

L2 Manusky secfy the spaication ifamaton

5 Click Next on the Important Information Screen. Enter the Information on the General
Information Screen, Check Run installation program as 32-bit process on 64-bit clients and
Click Next and Finish the Wizard.
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~

General Specify information about this application
Import Information

General Information

Summary Name: |

Progress Adminitirator comsents: \ o

Completion hud
e \ |
Software version: ‘ |
Optionsl reference: [ |
Administrative categories: \ =

Specify the installation program for this application and the required installation rights.

Instalation program: |msiexec / "GoogleCr Er ma'/g | [ Browse..

[ Run instaliation program as 32:bit process on 644t clients.

Install behavior: Install for system i

6 Click the Google Chrome Application. At the bottom of the page click the Deployment
Types Tab. Right Click the Google Chrome — Windows Installer, Click Properties

4 & Overview o
4[] Appheston Mansgement leon  Mama Deployment T
[t Applicatians ] Adobe Reader X1 (11.007) 1

[ Packages '] Google Chrome 1
[ Approvel Reguests BT Jeva 8 Update 11 ‘\\ 1
2] Gkl Canditions

S App-V Virtual Environments
T Windows Sidelcading Keys

1 SoMwase Updates
* || Dperating Systems Google Chrome
lcor Pronty  Name Deperdences  Te
I~ Google Cheome - W w
| Increase Pririty
Decrease Pricrity
= Copy
b fefresh 5
75 Delete Delete
ke Selected eme .
Mssets and Compli e
= B €l Update Centent
(57 seftware ibrry [7] Properties
B Monitoring
7| Administration
" [Simmary] Depioyment Types [Dapiyments |

7 Under the User Experience set Maximum allowed run time (minutes): 15

| el | Cortert | Frogms | Detocion Method | Ueer Expwience | Retum Codes | Dependences

Specdy user expenerce settngs for the apphcabon

raralaton benavor [rtatforsytem vi
Logon requrenent [ Vihthar or et @ uoer n togged on v
instalstion orogm viskiky: Hiddan hd
Specey the madmun run $me and ofthe appleaton The
‘estmated instalanon time deciays 10 11 User whan e ppleation ratals

Mesmuss howed rn tive fnnutes) E] =3 *

Estimatad installation tims grinutae). 0

Shaukd Configuration Manager enforos macic behavior regandess of the apckcation's intended behavior?

[Detemne bebaver based on reum coces v!
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5.3.3 Deploy Office 2019 - Office 365

1 Inthe Configuration Manager console, click Software Library.
2 Inthe Software Library click on the Office 365 Client Management.

3 Onthe far-right side of the screen Click Office 365 Installer.

Ol 365 Tt Marigement

LR

4 Enter the name of the Application and select the content folder. This will be in the

_\\serve_r\sdS\software\(foldername) format. Then click Next.

o [ Micrasaft Cfice 365 Chent Installaton Wizard

1 3! Application Settings
14

m Specify general sethings for this application

Dffice Sethings

Pdama:
Descnptern.

Cortert Lavation

Example: V\Server\Shae

5 Click on the Go to the Office Customization Tool.
- = :

Pl ot Offica 1% Chre czadlasion. Wizss

| | Bowes |
Difics 365 oiert ntalialion flea wi be coneinadad 1o hia icalion i They do rit aiacy
st

b 4
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6

9
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Select your architecture Office suit version and if you want Visio or Project installed as well.
Then click next.

Products and releases -~
Architecturs
Wiich architmshirs da you sant 1o dephoy? *
O
o) fd
Producis *
W It s o yo ol

Project

~
Additianal products
< >

Set which apps you would like deployed with the installation as well as the update channel

to use. Click Next.
Deployment settings

1

Excel
OnoDrive Desktop @D On
OQutiook &0 o

Publisher - on

Set your language after that click next again.
Deployment settings [ oo |

~  Products and releases 2
: Language
| e
:
1 language
.

Select sdditio

anguages.

Select additional procfing tools

profing tacls

| =
On the installation option set Shutdown applications. Then click next.

phoyment setings =]




10 Onthe Update and Upgrade option set if you want it to uninstall old versions of office. Then
Click next.

Deployment settings m

‘ “\ Update and upgrade )

Upgrade options

Uninstall any MS! versions of Office, including Visio and Project @ o

E Learn more about removing MS! versions of Office when you upgrade 7

Uninstall Visio @ o

Uninstall Project @ on

Uninstall SharePoint Designer @) On

Uninstall InfoPath @ on

Learn more about switching architectures during an upgrade cf

3 Next

11 Set that you accept the EULA and configure your product key and product activation
settings. Then click next.

B =
Deployment sartings [— m
i Licwraineg and acthstion -
{
Fi Autcanatically sceeps the FULA - ol
|
b Product hay
|
1 Otice Jtandarsd 2019 - Voiume Licenss
B
1 Product activetion
{
1 - -
1 b kel
1
< >

12 Next passed the deployment settings.
13 Choose your Default File format. Click ok then click Review.
1

Default File Format

Since Microsoft Office 2013, support has been added for opening and saving
files in the OpenDocument Format (ODF). You can customize the deployment | |
configuration to specify the format you would like as the user's default. ]

O Keep Current Settings
Choose this option to keep the current settings for this deployment
configuration.
Word - Not configured |
Excel - Not configured

PowerPoint - Not configured

@ Office Open XML formats
Choose this option to set the user's defaults for Word, Excel, and
PowerPoint to the file format designed to support all the features of
Microsoft Office.
Learn more CF

(O OpenDocument formats
Choose this option to set the user's defaults to use the ODF file formats
designed to support the features of third-party productivity applications
that also implement ODF. Many features of Microsoft Office are supported
by ODF but some content or editability may be lost upon save.
Learn more about the level of support by ODF for Microsoft Office features CF

Note: You can use Group Policy or the Office Cloud Policy Service cf to
manage this setting for all users.
Learn more about the differences between formats o
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14 Review your settings then click Submit.

b5

. BNV TEAMR R

15 Select that you want to deploy this application now and click next.

ey S w
ot g e
R

B | =
16 Select your collection and click next.

e =
17 On the Content page select add and select your distribution point. Click next.
P8

Tore e sk b b v e i

s a2t grasse, wnd e 1 . susrerthy muac s

= Pt e Summmary Cassl
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18 On the Deployment settings be sure to set that you want it to install and choose required if
you want to force it out or available if you want to make it available for users to install. Also
make a check mark by the option to allow end users to attempt to repair the software. You
can now click next through the rest of the options and finish the deployment.

! =] Micrasoft Dffice 165 Client Installation Wizard x

| ',,_.“Jg Deployment Settings
PR

Application Settings
Ciffice Settings
Deployrment

Speafy seitings lo control how this softwars is deployed

General
Content

Puposs: [ pualaie g
Scheduling

User Experience
2 [ Miow end ussrs 1o anempt bo repai this appication

Alerts
[ Fequis aamini approval 1 1 Wiz applicati

Sarmmary
Progress

Comgtetion

pym—— Tt

5.4 Distribute Software Application

1 Inthe Configuration Manager console, click Software Library

2 Inthe Software Library workspace, expand Application Management, and then Right Click
Adobe Reader Application, Select Distribute Content

Sottware Litary < Applications 3 items

A W

4 7 Application Management e | Rdaene Degloyment Types
[ Apphications | Adobe Readar K| (11.007) = -
= o _. Bs Manage Access Accounts
[ Packages o fizegie Chrome
" 1 Java 8 Update 11 & Creat= taged Content File
(& Approval Requests | ava 8 Update 1
1 Revision Histary
in Update s
5§ Crest= Deployment Type
Rainstate
_| Software Updates % &
) Ratire
Operating Systems Adaobe Reader X1 (11.0.07)
- ¥ Export
lean  Friofty | Nome e
’ = Copy 3
Acabe Reader ¥ [11 o ]
# Refr=sh 31
7% Delete Delete

Simulate Depioymant

Deploy

___*n Distribute Content

3 Click Next On General Screen. Click Next On the Content Screen. On the Content
Destination screen Click Add and hose Distribution Point and Select the
\\<YOUR_SCCM_SERVER>.<YOUR_DOMAIN>.local and click OK and

¥ & 0
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g! Content Destination

General Al Bistribution Poinis =
eneral e Pt e
Spacify the conlant destination L —
Content
e L - o never disiita. 10 Clous bion 5

Softwae Lidate Packsges s deirtuded 1o CGoud Disrbuton Poirts

Supnmary Corterr vl bee cisiri the folowing dstitxion pard groups and the Ayvakatd sty g ot

o dimributian poirt gmups that ane cumecty associsied wih collactiona [re=

Caonten! destination

Fiber

Name Dsscnpbion Aeocigions
There are ra items to show in this view. D.;ml_—mun Pain

Dictribution Paint

oK Cwoel

4 Next and Finish.
5.5 Deploy Software Application

1 Inthe Configuration Manager console, click Software Library
2 Inthe Software Library workspace, expand Application Management, and then Right Click
your Application and Select Deploy

Lol tuune Lk y
£&F Crverview
4 Application Management e ——
[+ | Apphications il fidcbe Reader X1 [11.0.0T) =
- R Manage Access Accounts
3 Packagas 1 Google Chrome =
! 1 . &| Creste Srmstaged Contert File

] Approwial Reguiests ru} Java 8 Undate 11 £

SRl % Revhion History
=] Blabai Canditions
Ui Uedata Statistice
# Ap- Yirtus) Envirormants
4§ Creste Deployment Type

| Dpemting Systems Adobe Reader XI (11.0.07)
lean  Prisrity | Name S ¢
t 1 Ecdobe Reader 5117 s
(3 Refresh i
7\ Delete Delete

= Sirmulste Deplayment
e S Dlepony

= Distributa Costent

3 Onthe General page of the Deploy Software Wizard, specify the following information:
Software — Displays the application you want to deploy. You can click Browse to select a
different application to deploy.

Collection — Click Browse to select the collection you want to deploy the application to.

4 On the Content page Click Next

5 On the Deployment Settings page, Chose the Action: Install and the Purpose: Available.
Click Next through the rest of the wizard.

—
3}13 Deployment Settings

beneel Specily seltings lo control how this soflware is deployed
Centent

Scheduling Action nsdal
User Experience

Distribution Points Pupose: | Avalabie v

Summary
Progress

Cempleton
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5.6 Update / Supersede Application
1 Create Software Application (See 5.3.1) for Latest Software Application.

2 Distribute Software Application (See 5.3.2).

3 Inthe Software Library workspace, expand Application Management, and then Right Click
your New Application and Select Properties

Deplagment Ty

Java 8 Update 20
on | Priorky | Meme ®
1 lava B Lipdstel

W fssets and Compliance
=0 Seftware Libeary

B8 tonisoning

| Administration

Beadly

4 On the Supersedence Tab, Under the application supersedes the following
application, Click Add and Click Browse. Select the Application to be superseded

(Java 8 Update 130) and Click OK.

Java 8 Update 20 Properties

Secutty
General Infomation | Applcation Catalog | References | Dsbuson Setings | Depioyment Types | Content Locations | SUperedence

¥ s appication s 30 upgrade o repiscement for an exssing appkcation i the Soltware Lisrary. specty 8 supsruadencs relstcnship thet
vl sy 1o future deployments snd Appication Catalog requests. Use the References tab to display any apphcains that superseds the.
ppication

Specify Supersedence Relationship

i_x T
Spacty the daplaymant types Lo ba replaced by this spplieation
Cument Applestion: vz 8 Upcdte 20

Supemeded Applemion [

Note: equredto o

This spplcation supersedes the follwing appbcations

Agphcation Okd Deployment Type Repiacement Deployment Typs  Active  Uninstall

Choose Application

\ Choose the apolication fo be that sy icetion are not daplayed
olemn, Fit=

&
2] Roct Name Vemcr  Admridsor Commeris Type
Adobe Readsr 141,007 Applc
Goagla Croma Foglic:
Java & Updabe 11 Aoplc
oK Concel

5 Under the New Deployment Type, Drop down the box and select the new Application
that will supersede the old application (Java 8 Update 131 — Windows Installer
(*msi)). Check the Uninstall if you need to for the old application to be removed.

Click OK and Apply.
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Speciy the deployment types to be replaced by ths applicaton.

Curmrent Application; Java & Update 20
‘Superseded Application: |Javaat.beﬁa‘l‘l | [ Browse... |
Specfy the new deployment type to replace the depl it types of the st ded application, The new deployment type

will upgrade the installed, superseded deployment type unless you select the Uninstal checkbox. Inthat case, The previous
deploymert type will be uninstalled and the new deployment type will be newly installed.

Old Deplayment Type Technslogy New Deployment Type torwa D
Java 8 Update 11 - Windows Installer (.. | M3! [Do not repiace v =

| Java & Update 20 - Windows hstaler (0

6 Deploy Software Application (See 5.3.3)

7 Once your workstation have updated to the latest software (1-3 weeks), delete the old
application and clean up the software distribution directory.

6 Configure Operating System Deployment (Imaging)

6.1 Copy Source Images
1 Inthe Software Distribution folder, under Images folder create sub folders Win10x64.

2 Copy install.wim file for Windows 10 x64, which is present on the Windows 10 DVD
under the Sources folder.

6.2 Customize & Distribute Boot Images to the Distribution Points

*** Do this for both x64 and x86 images
1 From the bottom left of the SCCM console screen, select Software Library.

2 Expand Operating Systems and select Boot Images.

Softwmars Library 4 BaotImages 2 ilans

Pl 9 Cvendew Search
¢ || Applicabon Mansgement leon Mame Wersin Compnent
+ = Sofiware Updates [ Boot image (x64| 53050016384
+ || Operating Systems. I Boot image (6] 5.3.5600,16364

=, Drivers 03 Reiresh 5
B Oriver Packages v V< Deste Delete
o

BE Corating System Images & Distribute Content

B, Operating Systen |rstaders 5 Uptate Distriation Points
@ Boot Image: | Create Practaged Content Fle
El Task Sequences Boot image [x86) 2. Manape decess Accounts
e Virtual Haed Disks 1 Mo
Surmmary |

Corment \ @ Set Smcurity Scopes

Architecture: = Fropertcs

Version: —

Language: English {Uiréted States]

LRE)
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3 Double-click Boot Image (x86).

Content Locatians [ Dpticnal Compenerts [ Secuty Content Locations | Optional Companents [ Secuty | )
Generd | lmages | Drvers | Custonizaton | Data Scunce | Do Access | Diatrbution Settogs | Ganeral | images | Divers I&mcrmzxm Data Scurce | Data Access ]‘mm

| Enzble prastart command Specify the image fle that contairs the boot image for 2ge. ¥ the file contains mutiple 0
Image tab to select the corect image.

Image path;

WSCOM-A-T se00l loca SMS_P S 0'\osd\boot 4 386 boot wr ] |

Image index: 1 - Microscft Windows PE (x85) v
Source version 2(8/15/2014 52309 PM)

Windows PE Background
[ Specity the custom backgrourd image fie (UNC path)
[] Update distibution poirts on a echedule

Docurs every 1 days efieciive 8/22/2014 1002 AM

\
[
Vhndows PE Scratch Space (MB) o |\ ] Persist content in ciert cache
Enable bnary diferental replication
Enzbls command suppont flesting cnly) | Deploy thie boot image from the PXE-enabled detrbution point

4  Select the Customization tab and select Enable command support.

5 Select the Data Source tab to make sure Deploy the boot image from the PXE service
point is checked and then click OK.

6 When prompted to update the Distribution Points, click Yes and then OK to close.
Configuration Manager ILI

. You have made changes that require you to update distribution points
_IA with a new version of this package.

Do you want Configuration Manager to update the distribution points
now?

7 Right-click the Boot Image (x86) and choose Distribute Content.

Boot Images 2 ftems

Ican Name s Wersian Comment Imnage i0:
] Boot image [xB4] 6.3.0600.16284 PEOOC0S
o Boot mags (6] LR [t BETRIN04
R Refresh F5
7 Delete Delete
—_— 31 Distrbute Content
# Updste Distribution Points
&| Creats Prassaged Content e
Boot image {xB6) Le Manage Access Accounts
Summary A
S & CetSecunty Scopes
:?. ture: ##6 | Z] Properties

B39 e .
English [United States) ‘

0 Targeted Lest Update
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8 Select Add > Distribution Point to select the server (SCCM-A-1.SCHOOL.LOCAL).

Content will be distributed to the following distibution points, distibution point groups. and the
distribution point groups that are cumently associated with collections

Contert destination:

Fitter...

Name Description

Associations
SCCM-A-1.5CHOOL.LO... Distrbution point

9 Click OK and Next.
10 Repeat Steps for Boot Image (x64).

11 Make sure the Content Status is Green (Successful) before you continue.

~ DL 2 s
— ! Search

Ican Mzme

il Komment Werzion Comment
i Haat image [x54) £.3.0600.16354 2060010384
L Boot image (5] £.3.9600.16384 53060015364
N &R . Ew i
Boot image {xB6) 1

Boot image (xBG)

Summary Content 5“‘-‘-‘/ Surnmary \‘Cnn:enl Sttus
Camment . Suceess. 0 Comment:
Architecture: 3G In Progress: 1

B Succsas: |
: B Failec O Birchitecture: HE& Ini Progress. 0
— Vermion: 6306 —j et N 6306 M Feded O
x 016 f o = 0E B Linkncwn: D
| 384
Languzge:

3 e 334
Englis ]c'f;'l:'tmd (Last Update: 8/22/2014 G Erglis 1 Targeted (Last Update: 3/22/2014
h A1 ANy y

W 10:12 A}
Minita .
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6.3 Capture Prepared Windows Image
1 Right click on Software Library, Operating Systems, Task Sequences. Click on Create Task
Sequence Media when the Create Task Sequence Media

Select the type of media

Media Type
Software Library < Task ! p Image
< S Ousrvisw Caan SUTmE Y Selact the tupe of new media [0, DVD, ar USE fash drive| or the file uzed to deploy or caplue an
i & Prograss coelaling syatem.
Application Management Teon i
= Cargletion 3
| Saftware Updates 5] " Slanckalone media
4 ] Oparstirg Systems E] Creales reda uzed o deploy operstng syslems wihout network access
ars 5] " Bootable media

B Driver Packages Ei Cieates meda ured o deply operatng syelems using Conligiar nfrastiuctue

B Operating System mages B

= < = : " ¥ Caphrs mediz

 Operating System Instaliers = Creates meda used to caphuie an operating system deployment image from 2 reference computer,
Boot Images B
B Task Sequences—— " " Preslaged media : :
7] Create Tack Sequence Cimales a file b be prestaged on a new hard difve Bl nides an opsrsing spster image
T | Coenbe Task Sequence Media T D —
Selec! this checkbow bo enable unattended aperaing avslem deplopment An unaltended opersing
“' Impaor: Task Sequance zpstem dealovment doe not promot for nebwork. conliguration of optiona tash saguencas.
Folder I™ Ao inaented oxetating svtem
¥

2 Onthe Select Media Type Page, Select the Capture Media, Click Next.

3 Onthe Media Type Page, Select CD/DVD set. In the Media File, browse to the path of where
you want to store the ISO file, give it a name like e:\capturemedia.iso. Click Next.

Select Media Type Specﬁy the media Type

Media Type

Boot Irnage
Summary Specify whether the media for this image deployment will use CD/DYD media or USB flazh drive.

Progress

Completion
" USE flash drive

Dirivie: I ﬂ
& COJOVD set

Medis size I j

Specify the name and path where the output files will be witten. IF multiple pieces of media are
required, a sequence number will be appended to the name for each piece of media,

Media file: Ie'\capturemadia iso| Browse. |

4 On the Boot Image Page, browse beside boot image, select your X86 boot image, click ok, then
click on Browse beside Distribution Point, select your distribution point. Click next to continue
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through the wizard.

Select Media Type Select the boot image for the media
Media Tyvpe

Boot Image

Specify the boot image that iz run frarm the media and the distribution paint to download the content uzed

ST ta create the media.

Progress

Tonigletion, Boot image: IBDD[ image [+8E] Brovess.. |
Distribution peint; | SCCM-A-1 School LOCAL

5 Burn this CaptureMedia.ISO to a CDROM or save it to a network share.
6 Loginto Prepare Windows Workstation as Domain Administrator

7 While in Windows of the Prepare Windows Workstation, Remove the workstation from the
Domain

7.a Click on Start, Right click on Computer, choose properties

7.b Click on change settings to the right of the Computer Name

7.c Click on Change, type in the name of a workgroup to join and click ok

7.d You will be welcomed to the workgroup, click ok

7.e You will be prompted to reboot the workstation. DO NOT reboot. we will
continue with the capture process and then reboot

8 Insert the ISO/CD/DVD on the Computer, While still in Windows (do not try to boot from this
ISO/CD/DVD) you should see the following

% Image Capture Wizard ==

i! Welcome to the Image Capture
e Wwizard

This wizard guides you through capturing a snapshot of ore
or more of the bard disk drives of this computer,

7] AutoPlay ol ® ==

[=& DVD Drive (D:) Configuration
= Manager 2012

" | Always do this for software and games:

Install or run program from your media

@ Run TSMBAutorun.exe
i+ Published by Microsaft

Engure that this machine i not a member of a demain and
then dick next to continue.

General options

'

View more AutoPlay options in Control Panel

Open folder to view files

Next = Carcel
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9 Click on Run TSMBAutorun.exe, Welcome to the Image Capture Wizard appears, click next..

ﬁ Image Capture Wizard (=3

Image destination

Indicate where you would like the operating system image to be created.

Enter the destination and file name for the captured operating system image.

Destination: |llsccrn—a—115D$’.Image:s\Capture\w in7Cap.wim Browse... |

! For network paths, enter the account and password used to access the path.

Account Name: | SchoohsCCM.Admin

Password: I PE————— [

qPreviou.s | MNext = I Cancel |

10 Enter a path and name for the WIM file
\\<YOUR_SCCM_SERVER\SDS$\Images\captured\CapturedWin10.x86.wim and then enter the
credentials of a user with permissions to write to that location School\SCCM.Admin, Click next.

Enter Image Information

SCCM 2012 Summit

Runoing. I plure Wzard

g"l SCCM 2012 Summit
-

Running: Imago Capture Wizard

Rurning sction: Prepare Operating System
AERRERNNERANNENNRE

Running action: Prepere Configuration Maneger Cient
Ll LL])
Iritainng the System Center 2012 Configuration Manager clent. .,
L

Rurning sysprep command.

System Restart

SCCM 2012 Summit
Running: Image Capture Wizard

Initializing system shutdown . . .

[TITTIIL]]
The computer will automatically restart in 0:25 minutes.

Restart Mow I
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11 Click Next and Click finish to start the capture process, notice how it prepares the config
manager client and then it syspreps before rebooting into Windows PE to capture the system.

Installation Progress ]|

Capturing volume 1of 1.,
L]

12 Your workstation will reboot automatically into Windows PE without you having to press the
F12. You will only need to monitor the progress from here to the end of the process.

13 Once the workstation has finished the capture process there will be a win10cap.wim file located
on the SCCM server that you can Create an Operating System Image and a Task Sequence to be
deployed.

6.4 Add Operating System DVD Image (Install. WIM)
This will be the install.wim image file copied from the Windows 7 or Windows 8 DVD.

1 Inthe SCCM Console, click on Software Library.

2 Expand Operating Systems, right-click Operating System Images and choose Add
Operating System Image.

Software Library < Operating System Images 0 iterr
4 &l Overview —| Search

» LI Application Management lcan Narme

» || Softwars Updates

4 || Operating Systems
(%] Drivers

BS Driver Packages

EL Operating System Images ~
: ‘@l Add Operating System Image
B Operating System Installers )

&5 oot Images Falder ¥

[ Task Sequences | |
= Virtual Hard Disks v

# Assets and Compliance

ﬁ Software Library
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3 Browse to \\<YOUR_SCCM_SERVER>\SD$\Images\Windows10x64\sources\ to find
and select the install.wim from this folder.

Specfy the path to the operating system image file.

Path: Example: \\servemame\sharename\path\file. WIM

['\\socm-a-“stVnages\Wndows?xG&MmesWaﬂ wim ] [ Browse... |

4  Enter the Name, Version number, Comment and complete the wizard. Make sure the
name is discriptive enough to know what this image contains.
Windows 10 x64 (install.wim)

Catauics Type general information for the operating system image

Summary
Progress Provide a name, version, and comment for the operating system image.
Completion

MName: |Windows 7 PRO %64 {install wim)

Version: |

Comment: |

5 Distribute Content after the image has been added successfully.

lcon Name Versian Sche
L Windaws 7 PR 264 (instaliwam}
_‘g Schedule Updates
Cancel Scheduled Updates
" | nm =
[ 3 Refresh
Windows 7 PRO x64 (install.wim] K Delate
Summary .-—-* @ Distrbute Content
T ; i 2
Gl 35 Update Distribution Points
Warsian & Create Prectaged Content File
Language: Englis
Juag f 2= Manage Acoess Accounts
flimita

6 Repeat steps for each Version of Windows you intend to deploy.

6.5 Add Operating System Captured Image (CapturedWindows10.WIM)
This will be the image file captured from the WDS or SCCM Capture Process.

7 Inthe SCCM Console, click on Software Library.

8 Expand Operating Systems, right-click Operating System Images and choose Add
Operating System Image.
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10

Software Library < Operating System Images 0 iterr

4 ffﬁ Overview —
| Application Management leon Mame

_| Software Updates
4 || Operating Systems

\#| Drivers

m

BS Driver Packages

EE Operating System |mages ~
- @l Add Operating System Image
B Cperating System Installers )

Folder 3

& Boot Images
[ Task Sequences | |
= Virtual Hard Disks v

"f‘. Assets and Compliance

ﬁ Software Library

Browse to \\<YOUR_SCCM_SERVER>\SDS$\Captured to find and select the
CapturedWin10x64.wim file from this folder.

Specify the path to the operating system image file.

Path: Example: \'\servemame'sharename"pathfile WIM

“scom-a-1'sdSmages \ Captured  Captured Win 786 wim | | Browse ..

Enter the Name (Captured Windows 10 En x64), Version number (Date Captured),
Comment and Click Next and complete the wizard. Make sure the name is discriptive
enough to know what this image contains. You will need these comment to know what
imgaes are what in the future. Recommend that you put the date the image was

captured.
e Type general information for the operating system image
Summary
Progress Provide a name, wersion, and comment for the operating system image.
Completion
Mame: |Ca|:|tured Windows 7 En x86
Version: [8-22-14
Comment: Image Captured from Waorkstation|



11 Distribute Content after the image has been added successfully.
Qperating System Images 4 items

Search X Search | Add!
lcon MName Version Scheduled Updates Date
B Captured Windows 7 En %86 8-22-14
okl
X i . [z Schedule Updates
“;: Windows 7 En %86 (install wim)
B Windows 7 PRO x64 (install.wim) e
(e
[ Windows 8.1 En x64 (install wim) & Refresh
75 Delete
< m gzé Distribute Content
Captured Windows 7 En x86 /5‘3 Update Distribution Points

‘& Create Prestaoed Content File
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6.6
1
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Create the Base (DVD) Operating System Installation Task Sequence

From the bottom left of the SCCM console screen, select Software Library.

Expand Operating Systems and right click on Task Sequences, and select Create Task
Sequence.

Select Install an existing image package and click Next

Create Mew Task Sequence

Task Sequence Informatis

Create a new task sequence

Install Windows

Configure Network Atask sequence performs multiple steps or actions on a client compt

without requiring user intervention. Select the type of task sequence

Install Configuration Mar task sequence editor to add steps to your task sequence.

State Migration
Include Updates
Install Applications

Summary Select a new task sequence to be created.
Progress ® Ingtal isting i ok

(®) Install an existing image package
Completion /"

() Build and capture a reference operating system image
) Install an existing image package to a virtual hard disk

() Create a new custom task sequence

Fill in the Task Sequence name that will be visible during imaging and click Browse to
select the corresponding Boot image.

Create New Task Sequence

Install Windows

Specify task sequence information

Configure Metwark

Install Configuration Mar

Task sequence name: [Wirdows 785 Base DVD finstallvim)

5tate Migration

Include Updates Description: T '\

nstall Applications

Summary \‘ w
Idare: Boot images:

] Filter....

Boct image {«£4] 6.3.9500.16324 an-US
Boct image 486] 6.3 3500 16384 en-1I5

] Root




5 On the Install the Windows Operating System screen, click on Browse and select the
corresponding Windows Image.

Create New Task Sequence Inigiq)| the Windows operating system

Task Sequence Informatis

Install Windows
Specify the Wirdows operzting svstem image and installation rformation.

Configure Network

Install Configuration Mar

Irage peckage: | (1] Browse... |
Stace Migration T
Image: | v
Inciude Updates
Install Applications [l Patilion and format the targst comptier before instaling the operating sysiem.
Summar RS T S e -
Progress
Completion Feldera: Operating aysiem imagea:
] Root Fiter

Captured Windows 7 Enw26 8-22-14 en-LIS

Viindows 7 En 86 [nstall wim) en-US
/A Windowe 7 PR xE4 finetall wim) en-US
Windows 8.7 Enxb4 install wim) en-US

6 Make sure Partition and format the target computer before installing the operating
system is Checked. If you do not plan to use BitLocker, Uncheck Configure task
sequence for use with BitLocker. Do not Use a product key, enter a password for the
Local Administrator and click Next.

Create New Task Sequence  |nstall the Windows operating system

Tazk Sequence Informati

Confiqure Network Specify the Windows operating system image and instalation information.
Install Conf o0 M
netall Comfigurstion Mar e package:  [Wiindows 7 En 35 jrstol wim) e | [ Bowse
State Migration
Image: | 1-Wiindows 7 ENTERFPRISE v|
Includs Lpdates
Install Applications [+#] Patiicn and format the target computer before netallng the operating eystem.
Sty [ liConfiaurs fask for Lise with B[ ocksr
Progress ﬁ =
Cornpletion Spedfy the Icensing nformation for the Windows instalation.
Froduct key: | |
Serverlicenaing mode: | D riot speciy b |
Il ses v Lonnecton e

 Rendarrly genercie the local edministrator password and dsable the account en al supported
= platforms fecommended)

‘_“-"* ®) Ermble the accournt and speciy the local adminisrator passward

Pozsword:

Corfimn pasaword: |ouo-ou. |
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7 On the Configure Network screen, select Join a Domain and click Browse for Domain

and select <YOUR_DOMAIN>.local, click OK. Select Browse for Domain OU and select
Domain Workstations\Unsorted and Click OK.

Create New Tesk Sequence.  Configure the natwork
Task Sequence Informati & Jon a domain
Install Windeves i e e
: 0 [schoctioc: e
Configure Network Select he doman or workgmup o pin
Install Configuration Mar P Dovan Ol I o
) doin a workgra
State M Browse for a Container -
Soacly
Seiact an Active Direcicry Cortansr o
Accoun St
®1 Jan 2 domen i <
. Domain: o[ see= | = 33 sl pi
Bragress + 0] Computers
- oot . & Domsn Cortroliers
Completion Domain OU mﬂ'mﬂlﬂ —M“E"J {1 57 Domsn Member Sarvers
] [ 3 Doman Worksatices =
Specfy the zccourt D°"'='“ 4 A Admistrbon WS
----- 4 5 Blemertay WS
Dl = | 4 3 High School WS
4 3 Technolgy WS

2 Facuty

8 Click Set for Account name, Browse for SCCM.Admin. Enter Password and click OK.

# Join & doman

Comain: lecnzellocal [ Browse..
Domain OL: LOAF/0U-Lnaoted OU-Toma Wotetstd | Browse..
Specy the account that has pamizsion to jon the domain. /
Agcount: ("] | Sei
Use ramie [EeHED acom adrin Browese .

Exampie: Domain’ Ussr or WiElabiet

Pasawond: |uuuno

Corfim password ||nouuo

Veilly <= F

Digta source: | Aetives Dractony L J
Fath: |LDAP-/0U-Unsorted GU-Doman Warkstztions, 0t Browsa..

\* Test cornection |

**Make sure SCCM Admin has rights to join machines to the Domain.

9 Click Next on Install the Configuration Manager Client. On the configure State Migration
screen, uncheck all the Capture options and click Next.

Create Mew Task Sequence  Canfigure state migration

Task Sequience Informati
Install Windows

Configure Netwark Selert the setfings on the desiinafion computsr io migrate as par of this imege deployment
Install Cenhiguration Mar

T i e i ke
Include Updates
|| Caphure uss=r s=tings and fl=s
Install Apphcations
Summary 4 Moreott Corporation User State Migration Tor
Progress e Lompr o fie 3 7

Completion

Thiz actian wil capturs the configuratian of the netweark.
| Capturs natwark asings

Thiz ctizn wil capturs the Viindows specdic setbnge

--""h| | Capture Mesosaft Windows s=ttings



10 On the Include Software Updates screen, select All software updates and click Next.

Create New Task Sequence
Task Sequence Informati
Install Windows
Configure Metwork
Install Configuration Mar
State Migration

Include Updates

Install Aoplications

®) Ml sottware updates
I} Do net instal ary acftware

Sumnmery
Brogress

Completion

Inciude software updztes

Iraiall ecfiwars upcates assigned o thie computer.
O Marwztory softwers updaies

updatea

11 On the Install Applications screen Click Next, click Next through the following screens

and complete the wizard.

12 Right-click the newly created Task Sequence and select Edit.

13 Click on Add -> General -> Set Task Sequence Variable.

** This step is ONLY required if the install.wim file is used from Windows 7 DVD

Sample Task Sequence Task Sequence Editor

i LAdd - || Remove = ;3 Properties ICPHO"‘! |
Mews Group ’!’T Typa: Im
= PE
| General r Run Cormand Lire W
Disks b Run PomerShell Soipt
User State 3 Set Dynaric Varizbles |_
Images 3 Irsial Applicaton
Drivars b Irstal Packags i
Settings 3 Iretal Software Updates re Updates
& Jain Doman or Workgroup =
Connect ta Network Falder
Rectart Computer
| Set Task Sequence Vaneble
Check Readiness

14 In the Task Sequence Variable put OSDPreserveDriveletter and FALSE in the value field.
Move up Set Task Sequence Variable above Apply Operating System using the icon to

move variables.

Add ~ | Remove 30 (3

[*4 Install Operating System
a- Restart in Windows PE \
& Parition Disk 0 - BIOS

Partition Disk © - LUEFI

Set Task Sequence Varable

Apply Operating System

Apphy Windows Settings

Apply Network Settings

& Apply Device Drivers

|4 Setup Operating System
a' Setup Windows and Corfiguration
@ Install Updates

Properties | Options :

Type:

\ Name:

Description:

|Set Task Sequence Varable

|Set Task Sequence Varable

Enter the task seguence vanable name and value.

Task Sequence Varable:

Value:

|OSDF‘reserve DriveLstter

Falze

/I
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15 Select the Apply Windows Settings. Change the following:
- User name: Public School District

- Organization Name: Public School District

Add - Femove 2 5| | Fropartes | Opfions

Install Operating System Type:
@ Festat in Windows PE

[ Aoty Windowes Settngs |

Namz:

Panition Dizk 0 - BIOS
g Fariition Disk O - UEFI
{8 Set Task Sequence Veriaie
&# Apply Opersting System

|.-\p_ﬂ)- Windows Seftings |

Descrption: |.-\c!iana to apply Windaws ssttings - |

Enterlicersing ard registration rfomation for instaling Windows.

&# Apply Windows Settings

¢ Foply Network Settings

Fpply Device Divera toar m Puble Schoel Distnct |
'qi Setun Windaws and Confioration Mar, Crganizaiion rame: {Publc Schoal I'.ngmc:| |
& Insts] Updates Product key: |

Serverlcersng: Do not epacity bl

Madmum cenneciions: 5 o

-, Randomly generste the local administrator pssword and dsshle the zccount on =l
~* supportad platfome fecom:

[l

Ensztle the 2ccourt end apacty the lecal admnistrator psaword

Pazzword* i LI |

Corfim peeswaord:

16 Click Apply and OK to save and close

Create the Captured Image Deployment Installation Task Sequence
1 From the bottom left of the SCCM console screen, select Software Library.

6.7

2 Expand Operating Systems and right click on Task Sequences, and select Create Task

Sequence.

3 Select Install an existing image package and click Next

Create Mew Task Sequence

Task Sequence Informatis

Create a new task sequence

Install Windows

Configure Metwork Atask sequence performs multiple steps or actions on a client compt

without requiring user intervention. Select the type of task sequence

Install Configuration Mar task sequence editor to add steps to your task sequence.

State Migration
Include Updates
Install Applications

Summary Select a new task sequence to be created.
Progress =

g (®) Install an exdsting image package
Completion .ﬂ

() Build and capture a reference operating system image
() Install an existing image package to a vitual hard disk

() Create a new custom task sequence

4  Fill in the Task Sequence name that will be visible during imaging and click Browse to

select the corresponding Boot image.
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Create New Task Sequence  gpacify task sequence information

Install Windows
Caonfigure Metwork

Install Configuration Mar

State Migration Task sequence name: Windaws 7«BE Capturad Image 2

Include Updates Daecription: Image Captured on 8-22-14 ~

Install Applications
Summary oy
Progress !
Completion RS | ] Browse...

Select a Boot Image
Folders: Boot images:
1 Reot IFils'...

b J| Eoat mage {55) 5.3.9600 16334 en-US

Eoct mage {c54) 6.2.9600 16234 en-US ‘

5 On the Install the Windows Operating System screen, click on Browse and select the
corresponding Captured Windows Image.

Create New Task Sequence.  |notall ihe Windows operaling system

Task Sequence Informati
Install Windows
Specfythe Windows coerating systemimage and installation infomation.

Configure Metwork

Install Configuration Mar

Imzge packags: | |o | Browse... |
State Migration - B
Image: | W |Q
Include Updates _ — —— -
Install Applicatif Sﬂecﬁan—&}maiinqgmm.lﬂmge -
Summa
- Folders: Oparating system images:
Progress
Cormpletion ] Root I;'"-er--

Captured Windows 7 Enx86 82214 erLiS
Windows 7 En =86 (nstall wim) en-J5
Windows 7 FRD x84 jnstall wim) en-L1S
Windows .1 Bn x64 fnstall wim) en-US

6 If you have more than partition from your captured image, make sure you have the
Image All Images selected. If you only want the system partition from the Captured
Image, select the 1:1 Image. Make sure Partition and format the target computer
before installing the operating system is Checked. If you do not plan to use BitLocker,
Uncheck Configure task sequence for use with BitLocker. Do not Use a product key,
enter a password for the Local Administrator and click Next.

Create New Tack Sequence |t he Windows operating system
Tazk Sequence Infarmatn

Configute Hetworic Spaciy the Windows ooeraling system mage and nstal=icn infomation.

Inst=ll Corhiguiration Mar

mags peckege:  [Copeed Wb TEn B8 B2 enlS | [ owee,

State Migration

: T
Thelita s \"“* = T ———

pplication: 1 Partitior arvd fomat the target computer befors iretaling the operting eystan
il || Corfigure task smqummcs for uss wih Bilacker
Progiéss =
Completion Spacy tha keeneng rfomiation for the Vilndowa ratalaton,
Prockict kay: |
Sarver doansing mece: | Do nat epmciy -
" platioms (oonmensed)
® Erable the ccourt and specfy the locel adminsrator naaswerd
Famswant earRany |
Corfim pazeword ] |
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7 On the Configure Network screen, select Join a Domain and click Browse for Domain
and select <YOUR_DOMAIN>.local, click OK. Select Browse for Domain OU and select
Domain Workstations\Unsorted and Click OK.

Create New Task Sequence.  Confiqura the natwark
Task Sequence Informati ®. Jor a doman
Install Windees Do o e
i 2. {schoct joc: e
Configure Network Select he doman or workgmup o pin
inetal Corfigurston Mar Dovan Ol I o
- dairs a warkgrou
State M Browse for a Container -
Soacly
o Seiact an Active Directcry cortaner —Set

1 Jan 3 demain
Domain: [ 0| Eee | =3 school -
23 Computers
2. Domsn Cortroliers
4 5 Doman Mamber Servers
= 31 Doman Workestices
Specfy the aocoure 4 Demains: 2% Admrstrabon WS

Accourt: | ot - -w 2
‘
1

Erogress

Completion Domah OU  Selecta Domain . Ercwe..,

8 Click Set for Account name, Browse for SCCM.Admin. Enter Password and click OK.

# Join & doman

Domain: lechoal local | Browss...
Domain OU: LOAF/0U-Lnaoted OU-Toma Wotetstd | Browse..
Specy the account that has pamizsion to jon the domain. /
Agcount: ("] | Sei
Use ramie [EeHED acom adrin Brovese .

Exampie: Domain’ Ussr or WiElabiet

Pasawond: |uuuno

Corfim password ||nouuo

Veilly <= F

Digta source: | Aetives Dractony L J
Fath: |LDAP-/0U-Unsorted GU-Doman Warkstztions, 0t Browsa..

\# Test cornection |

**Make sure SCCM Admin has rights to join machines to the Domain.

9 Click Next on Install the Configuration Manager Client. On the configure State Migration
screen, uncheck all the Capture options and click Next.

Create Mew Task Sequence  Canfigure state migration

Task Sequience Informati
Install Windows

Configure Netwark Selert the setfings on the desiinafion computsr io migrate as par of this imege deployment
Install Cenhiguration Mar

T . o it copre e s s
Include Updates
|| Caphure uss=r s=tings and fl=s
Install Apphcations
Summary 4 Moreott Corporation User State Migration Tor

Progress
Completion

Thiz actian wil capturs the configuratian of the netweark.
| Capturs natwark asings
Thiz ctizn wil capturs the Viindows specdic setbnge

--"'* | Capture Mesosaft Windows s=ttings
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10 On the Include Software Updates screen, select All software updates and click Next.

Create New Task Sequence  |nciypo software updates
Task Sequence Informati
Install Windows

Configure Metwork Iraiall ecfiwars upcates assigned o thie computer.

Install Configuration Mar O Morsii oo s des

State Migration =
2 ® Mlsotwere updates

Include Updates.

Install Aoplications

.} Do net instal any ecftware updatea

Sumnmery
Brogress

Completion
11 On the Install Applications screen Click Next, click Next through the following screens
and complete the wizard.

12 Right-click the newly created Task Sequence and select Edit.
13 Select the Apply Windows Settings. Change the following:
- User name: Public School District

- Organization Name: Public School District

Add - Remove 5" (3| | Properbes [aﬁona
Install Opcrating System Type: [3y Windows Setings |
@ Festat in Windows PE e 3
Fanition ik 0 - BI0S Nams [y Wdows Sstings |
Fariition Disk 0 - UEFI Descrption:

|.-\c!iana to apply Windaws ssttings A |

{8 Set Task Sequence Veriaie

&# Apply Opersting System
@ Apply Windows Setungs Enter licersing and registration rfomation for instaling Windows.
FAopty Network Settings
Aply Divics Divers Usar h Pubke Schoel Distnet |
.ﬂi Setun Wlnd:\fs :::?::fgmmn Mar, Crganizaiion rame: .Pubic Schoal Ulgh'w‘:‘[ |
B Instal Updates Praduct key: L N |
|

Senverhcersng:

Madmum connsciions: 5

Dnmeci%y L
-, Randomly generste the local administrator pssword and dsshle the zccount on =l

~* supportad platfome fecom:

&) Enzhle the 2cocunt and apacfy the local admiistator pasawerd

Pazzword* lean L1 |

Corfim password

14 Click Apply and OK to save and close

6.8 Deploy the Base DVD OS Install Task Sequence.

1 Click Software Library, Task Sequences and right-click on the Windows 7 x86 task
sequence, and select Deploy.

2 Click Browse to select the Windows Imaging Collection Device Collection and click OK.
3 If prompted with a message that the collection does not contain any members, click OK.

4 Click Next.
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5 Onthe Deployment Settings screen, check the Make available to boot media and PXE
and then click Next.

6 Click Next through the rest of the screens and complete the wizard

7 Add workstation objects you wish to image to the Windows Image Collection. Make
sure the All Unknown Computer Collection is a member of this collection also.

6.9 Add Software Applications/Packages to Image Task Sequence.
1 Click Software Library, Task Sequences and right-click on the Windows 7 x86 Base DVD
(install.wim) task sequence, and select Copy.

Task Sequences 2 hems
Search

an Mame Description Padeage ID

] Windaws 72862 ]

(E5] Windows 7 286 C|

=

& Edit
Enable
[Creaile

\ #* Export
% Copy

|

Windows 7 x86 Base [ * &0 Fs
75 Delete Delete
Summary b Depioy
Rlanes %7 Distribute Content
Drescription: -
Fackage I |&| Create Prestaged Content File
Package Type: e r—

2 Click OK to confirm the copy was successful. Notice the name Windows 7 x86 Base DVD

(install.wim)-PSD00013. This is the name of the new task sequesnce that was created.
Configuration Manager -

The copy operation has completed successfully, and the following are
new Task Sequence Name(s)

{ Windows 7 %86 Base DVD (install.wim)-PSDDDD‘lD

8l |Page



82|Page

3 Right Click the new Windows 7 x86 Base DVD (install.wim)-PSD00013 task sequence
and select Properties.

Task Sequences 3 [tems

Search 3 Search Ad
leon Mame Description Fackage ID Date
E Windows 7 x86 Base DVD (install.wim) P3E000TY /22
El Windows 7«86 Base DVD [install wimiZSD00013 DELOANT 2 8422
] Windows 7 x86 Captured Image I 4 Edit 822
Enable
! & Disable
n A Eport -
Windows 7 86 Base DVD (install.wim)-PSD00013 z| Copy
(% Refresh 5
Supfmaty 75 Delete Delete
Nams..- ) Windlows 7 %36 Base OVD {insf Deglay
Description: 3
Package |D: PSDO0013 | @5 Distribute Caontent
Package Type: 4 5

Boot Image ID: PSOO0004 || Create Prastaged Content File

iS5 Move

@' Set Security Scopes

\‘ E| Properties

4  On the General Tab, Change the name to Windows 10 x64 DVD (install.wim) -With

Apps.
B Windows 7 x86 Base DVD (install.wim)-PSD00013 Properties [5G

General | Advanced I Security

Name: [Windows 786 DVD nstall wim)-With Apps| |

Description: A

Category: W

Progress notification text:
® Use default text:
"Running: <task sequence name>"

) Use custom text:

5 Click OK.

6 Right Click the new Windows 10 x64 DVD (install.wim) —With Apps and Click Edit.

Task Sequences 3 items

Search
lcan Mame DCrescription

E| Windows 7 x80 Base DVD {installwim)

& Windows 7 x86 Captured Image Image Capture
[ Windows 7 x86 DVD (installwim)-With Apps

| 2 pilE

Enable
1 nicakia

7

7 Make sure you have Install Updates Highlighted and Click Add and Select General. Click

Install Package. Enter the Name of the Package Rearm Office Activation. Click Browse
and Select the Microsoft Rearm Office Activation Package and verify that the Program



OSPPRearm

&dd —L e rnove

4 Pmueﬂiag:aﬂ' |

New Group rtem Type: Group
PE
[ Geneal v Run Command Line el Cpartng Syat Tipe [insi Package ]
e : e TErE T e Restan i Windaws PE
/ o ript \Actions to nun in Vo i Nomes .‘”"‘pamm ffice Actrvatian |
[0 Userstae v Set Dynamic Variables i Farttion Cisk 0- UEFI o .
Images b Install Application - : £ ke sorince Mty ) | &
) = o thig sction. Hfppy Cperling System
Drivers 3 Instzll Package Apply Windowa Setings.
Setbiny 3 Appiy Netwark Settngs
s Install Software Updates P Ciicn D @ instel = s softwae package
m Join Domain or Workgroup |3 Setup Operating System
Connect to Matwaork Felde SI_:"; ‘Windowa and C Seloct tha aafty 1o retal
Irstl Updates
Restart Computer Feam OFice Acvanion Package: (et Fsom Offica A<t | [CEwee ]
Set Task Sequence Varahle Frearam: [0=PPReem v
Check Readiness

et anfiwars packagea accordng to dyramic vartae s

8 Click on the Options Tab and Check the box Continue on error.

Add -

Remove | 39 G2

[ Install Operating System
Restart in Windows PE
Partition Disk 0 - BIOS
Partition Disk 0 - UEFI
Set Task Sequence Varable

/

Apply Operating System
Apply Windows Settings

[ Disable this step

[w] Continue on emor

o™

| 2] Add Condition ~ | > Remove | X R

There are no items to

Run Command Line

Run PowerShell Scnpt

Set Dynamic Yarizbles

Install Application ="
Install Package

Install Software Updates

Join Domain or Workgroup
Connect to Metwork Folder
Restart Computer

Set Task Sequence Variable

Check Readiness

7 Remove

Add ~ | Remove | 29 8

|4 Install Operating System

Restart in Windows PE

Partition Disk 0 - BIOS

Partition Disk 0 - UEFI

Set Task Sequence Variable

Apply Operating System

Apply Network: Settings

Apply Device Drivers

|4 Setup Operating System
Setup Windows and Configuration
Install Updates
Reamn Office Activation

Install Application

5 Remi

There are noitemns to sho

Pmpurt’m Options
Type: [ nstal Appiication |
Mame: | mstall Appiication |
Description: ||

®) Installthe following applications

X @@

Name

Status Administrator Comments

There are no items to show in this view.
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10 Select the Application you would like to add to the image and Click OK. Repeat the
Process until you have added all the applications you would like to add. Make sure you
check the box If an application installation fails, continue installing other applications
in the list.

[ = —

Select software for this deployment

Folders: Fiter.. ;
] Root Name Wersion Administrator
Adobe Reader X (11.0.07)
Google Chrome
Java & Update 11
Java & Update 20

Add v Hemove =) (2| Propertias | Oters
|73 Install Oporating Systom st [Inetzi Boptcaten
Reestan n Windows PE T
Parttion Disk - 8103 fne: ittt Ak |
Partiion Digk [ - UEF] Descrption: 1|
Set Task Sequence Vaneble
Fpoly Oparaling System =1
oy Winckise Seflings
Netuerc St = e
9 bisdanorrid 1Bkl i bt sppic o I ESENE
B = pouk | Hame Seatus Acmristraior Comments
o w2 Gl | | ot e 11007 Vaid
Flearm Dffice Actrvstion | Gougle Ciaome Vi
Instail Appicmier: | dmya & Lpelate 20 i

[t Instzl applcmions accardng o dynamc wanshie kst

[V Continue on emor

/, " |7] Add Condition ~ | < Remove | X R

| There are no items to
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12 Use the button at the top to rearraing the tasks to have the Install Applications above

Packages and Updates
Windows 7 x86 DVD (insta

Add ~ | Remove 39 (3 | Properties | Opt
|4 Install Operating System Type:
ﬁ- Restart in Windows PE
&k Pattition Disk 0 - BIOS ™ Name:
¢ Partition Disk 0 - UEFI Deserption:
ﬁ- Set Task Sequence Varable :
ﬂ- Apply Operating System
ﬁ- Apply Windows Settings
ﬁ- Apply Network Settings .
ﬁ. Apply Device Drivers ®) Install a sii
|4 Setup Operating System
ﬁ- Setup Windows and Configuration Select the so
ﬂ- Install Application
8 Package:
Install Updates Program:
(71 Inetall anft

13 Click Apply and OK.

6.10 Import Device Drivers

1 Right Click Software Library, Operating Systems, Drivers, Select Import Driver

& Tmipork Mew Driver Wizond

gg Lecahs Drivar

| Locarenme | Specify alocation ta irport driver

Folder

Y = 4
s * _,g / Dirbvet Detalk
Import Saved Edit Enable Disable A Drtver b Packages
Driver | Searches ~ 7 itk Driver b Bt Tmages
; Crfe_at_e _S_gaf_ch _Ell_'iv_e: Sy
—- Progress
6 - | 2\ v Software Lbrary ¢ Ov oo
Software Library L
= :
4 & Overview
_| Application Management
| Software Updates
4 | | Operating Systems
* | [&] Driver x
5 Import Driver
IS Drive v B
= Opera; Folder 3
B Operating System Installers
& Boot Images
E! Task Sequences 1 | »|

Thig wizard alowe yau to impart one or more divers. You o3 ket Configurstion M anager find al
divaiz i the gven ratwark path o apacify a specifie driver to imparl.

(& Impent al crivers in tha following network path (UMC)

Browse . |

i~ lmpert a specific dnver by soecitung the nebwors path [UMC) ba k2 . if or batzatup oem fils

Erowse. |

Sourcs folder: I\\sccm—n-‘l\sds\lmuca\Dlivcls\EEmU

SOunsE I

Speciy the option for duplicale drivers

Import the driver and apoend a new calagony b the edicting cataganies ﬂ
= Previous | Teak = I Surrmany Carcel
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2 Onthe Driver location page, Browse to your drivers folder
\\<YOUR_SCCM_SERVER>\SD$\Images\Drivers\E6400, click Next.

< Impork New Driver Wizard E

gj Driver Cetails

T4 Manage Administrative Categories

rver

To azsigh acministiative categaries to the selected checls, elect the
check bokes.

Sun =

o] DD EEADD-win? 402 ZTHC\E G400\ BEhneky

o Croto.. | |EGHI0 w7 AD32THC7\EGA0MwinP BB ety
I Lenave S EGHID wind 413 2THCT\E G400\ BBty
EEHIwin A13-ZTNC7AE B0 w7 BBty

IBEEEN | 50w A ZTNCA C A Pt
£ B0 Wi 7 03 2TNCTAE G400 7B ety
£ B0 Wi 7 03 2TNCTAE G400 T\ EE ety
E 4007 A3 ZTNETAE BACDwiT BB ety

EE4UD—wh?AEI3-2TNE?\EEdm\wh?\hﬂﬁ\nil';[
13

ktal them
ing.
Cancel
@ < Frevious | Next = | SLIMEry. | Cancel |

[ —) 5

3 Onthe Driver Detail Page, Click Categories, Click Create (if you need to add a new Category)
and enter Dell e6400. Select the Dell e6400 Category and Click OK.

J Import New Driver Wizard x|
i [T— #Bcreate Driver Package
¢ S pezily the lalowing infoimehon far the neve diver packaps:
Locate Driver EYTS [FEac0
Cxhver Diecails Commeni: =
#ad Crivar to Boak [mag
SUmmary
Frogeess LI
onfirmation
Specily 3 rehaork path UM C) whene Corfiguiation Mananger storss driven: added to this packaps.
Paih: [Fazem= 1edghmages ivers P ackaged Browss. . |
Ekample: Whservemamehsharsname:
o |
4
Maw Package. .
¥ Updata digfiibuion points phen firizhed
@ <Pevus | Memr | coeny | ool |
| | ¥

4 On the Add Driver to Package Page, Click New Package (If you need to create a new
package), Enter Name E6400 and path
\\<YOUR_SCCM_SERVER>\SD$\Images\Drivers\Packages\E6400, Click OK. Make sure the
Update distribution points when finished is Checked. Click Next.
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u |Update distribution paints when finished

< Previaus | Mexk = I

Summary |

Mame Package ID Select Al

[ | Boot image [x64) RSDO0002
Clear &l

[ | Boot image [85) RSDO000

Cancel

5 On the Add Driver to
Boot Image Page, make sure
NONE of the Boot Image
Packages are selected and the
Update distribution points
when finished are
UNChecked. Click Next
through the remain screens to
finish the Wizard.

6 If these drivers are

Network Card Drivers and are needed to be added to the Boot Image, you will be able to
add them to the Boot Image Package manually. ** We only want to put NEEDED drivers in
the Boot Image Packages.

14
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7 Configuring Reporting Services

7.1 Install the Reporting Services Point Role
1 Inthe SCCM Console, click on Administration, Site Configuration, and Servers and Site
System Roles.

2 Right-click the respective server and choose Add Site System Roles.
3 On the General screen, click Next.
4 Select Reporting Services Point and click Next.

5 On the Reporting Services Point screen, verify that the appropriate server FQDN is listed
and click the Verify button.

6 Click the Set > New Account to assign the report user.
7 Use the <YOUR_DOMAIN>\MSSQLAdmin account and click OK.

8 Click OK and complete the wizard.

7.2 Configure Reporting
1 Open Internet Explorer and browse to
http://<YOUR_SCCM_SERVER>.<YOUR_DOMAIN>.local/Reports

2 Select the Properties tab, and click on New Role Assignment.

3 Enter <YOUR_DOMAIN>\Administrator (or AD Security Group) and assign desired
permissions.

4  Click OK.
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8 Backup and Restore SCCM Primary Site

This document is intended to provide the understanding of the general case backup requirements of
SCCM, a sample backup strategy, and performing a restore of the site. Backing up the SCCM site process
avoids loss of critical data ensuring that sites and hierarchies are restored with the least amount of data
loss. Before the backup process is started on SCCM server, a few things should be kept in mind:

- SMS Writer service must be running for the process to complete successfully

- Backup schedule should be configured for an appropriate time that is outside active working
hours to avoid any service disruptions.

The built-in Backup Site Server maintenance task performs backup of the following items:

- Configuration Manager Installation directory on site server
- NAL and SMS registry keys on the site server

- Master control file for the primary site

- Configuration Manager site database

- Information about the Content Library files

Some items are not saved automatically by the maintenance task and should be considered for inclusion
in manual backup tasks. Items that are NOT backed up by the Backup Site Server maintenance
automatically are:

- Package, Software, and Driver source files

- User State Migration Data (if applicable)

- Any custom reports and extensions used to create them (if applicable)

- The content library stored in the <SMS-Drive:>\SCCMContentLib folder
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Home Share Wiew Manage b ﬂ
© = 1t |ca» ThisPC » SCCME) » v & | | searchsccM (E) o |
Hr Eavorites Mame = Date modified Type Size
‘ Desktop _ downloads 271872015 1:56 PM File folder
@ Downloads . Microsoft Configuration Manager -\ 5/12/2015 8:46 AM  File folder
‘3—_.' Recent places . Remotelnstall 5/12/20159:37 AM File falder
L. SCCM_Backup 5/12/2015 &34 AM File folder
1%l This PC 0 SCCMContentlLib 2118723 212PM  File folder
L SMS_CCM 5/11/2015 3:48 PM  File folder
‘i MNetwork 1) SMS_SRSRP 5/11/20153:49PM  File folder
L SMSPKG 2M18/2015 216 PM File folder
L SMSPKGES 211872015 213 PM  File folder
L. SMSPKGSIG 21872015 238 PM  File folder
. SMSSIGS 2/18/2015 2:38 PM  File folder
\\_}, SoftwareDistribution _/ 5/12/2015 805 AM  Filefolder
1 wsus B/19/2014 4:37 PM File folder

8.1 Backup SCCM Site Server

To configure the built-in Backup Site Server maintenance task, launch the SCCM management console.
On the bottom left of the screen, select the Administration tab and expand Overview, if not already
expanded. Expand Site Configuration, select Sites and on the right plane click on the name of the
primary site**. On the top toolbar click on Site Maintenance.

**0Only backup of Central Administration Site OR Primary Site is supported. There is no backup support for Secondary Sites.

=N
3 9

2

& 0

»

Add Site Create Site Hierarchy Saved Tl | Set Security Properties

System Roles System Server Settings Searches = o ) e Scopes
Create Sites ‘ Search Classify Properties

[ (— " |% \ » Administration » Overview » Site Configuration »  Sites
Administration < | Sites 1 items
C Q‘ﬂ Overview Search -

» [ Hierarchy Configuration lcon Name Type Server Mame

=] PSD - Public Schanl Dist  Primarusite  SOCM-A-1 schoollocal

[ Cloud Services
4 [ Site Configuration _#7
5 Sites

B Servers and Site System Roles
B Client Settings
b [ Security
§3 Distribution Points
55 Distribution Point Groups

» [ Migration

,# Assets and Compliance

General e
fﬁ Software Library Site Code: W status Summarizers

.i Menitoring

IZ]—‘T(. Administration

EE>  Add Site System Roles
Eé Create Site System Server
Id'ﬁ Create Secondary Site
Retry Secondary Site
Recover Secondary Site
Upgrade
Show Install Status

i Refresh

Delete

F3
Delete

"_'ﬁ‘ Configure Site Components

Bl Client Installation Settings

Server Name:

Install Directo 3 Status Filter Rules

Build Mumber:

State: @ Set Security Scopes

Properties
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This should open the Site Maintenance window and a list of pre-defined tasks should be seen. Right

click on the task Backup Site Server and select Edit.

Site Maintenance -

Configure the list of maintenance tasks for this site.

Name
["F Backup Site Server

:jg'| Clear Install Flag
:@ Delete Aged Client Operations

[|4 Delete Aged Collected Files

:jg'| Delete Aged Application Request Data

:jg'| Delete Aged Client Presence History

4 Check Application Title with Inventory Information

:jg'| Delete Aged Replication Summary Data
[l Delete Aged Replication Tracking Data
[ Delete Aged Software Metering Data

:jg'| Delete Aged Software Metering Summary Data

<l

On the Backup Site Server Properties window, select Enable this task. After enabling the task click on
Set Paths* and browse to the location the backup files will be placed for the site server. Once the path is
set, set the Schedule for the backup. Set the Start after and Latest start time as per your needs**.
Select Enable alerts for backup task failures. Click on Apply and OK.

* If you set the path to a network share, Server Object must have Full Control to the Network Share and Folder Security.

**Recommended to schedule backups after hours. There is a minimum of 1 hour between Start and Latest Start.

=] Backup Site Server Praperties |i General |
m‘ ‘_@ This task backs up the site datab: L site server inf
L-‘:L Thie tzek backe up the site databass and importart ste server rmicmation. [ Enable this task Set Paths...
j / Backup destination: E°\SCCM_Backup -
[ Erﬁet_his tesk Sel Paths...

Backup destination:

Speciiy the locations to slore the site data backup and sile database backup. The site
server maching account must have ful corérol of the destration folder

Cestnation Optiane
® Local dive on ste serverforete data and database

() Metwark path {UNC name)for site data and daizbase

Eackup destinzti EA\SCCM_Backip | Browse...

Schedule
] Monday
Stat Aer. / [ Tuesday
T — ) Weberer
[ Thursday
Latest start time: / [ Friday
1:00 AM ] [V Saturday
[ Sunday

[C] Enable alerts for backup task falures

For additional information about data not included in the Configuration Manager backup and
recovery process. see the product documentation onlive,

o] o] L

This process will enable Backup Site Server maintenance task and schedule to run with the configured
settings. If you saved the SCCM Backup files to the local hard drive, make sure you back it up to another
location. In the next section we will discuss how to restore the site server.
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Home

Share

View

v 4 | Jl « SCCM(E) » SCCM_Backup » PSDBackup »

v G| | Search PSDBackup

ﬁ Favorites
B Desktop
it Downloads
"El Recent places

M This PC

3 items
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~

FY
Mame

. SiteDBServer

,,E SiteServer

E'I BackupDocument.xml
@ ConfigMgrBackup.ini
Ij smsbkup.log

Date modified

5/12/2015 B:46 AM
5/12/2015 8:50 AM
51272015 &:50 AM
5/12/2015 &:50 AM
571272015 8:50 AM

Type

File folder

File folder

XML File
Configuration sett...

Text Document




8.2 Restore SCCM Site Server
In Configuration Manager recovery from backup is part of the installation wizard. Before the recovery
process is started make sure you have completed the following steps:

- Rebuilt the server with the same name, patched windows updates and joined to the domain
- Volume Drive letter and paths are consistent with the previous installation
- MSSQL Server instance is installed and running on the server (if applicable)

- Recover File system

&a
,::3 Confirmation
Getting Started From backup: 5/12/2015 10:38 AM
Specify Location Type Recovery items:
Select Backup Location E\Mlicrosoft Cenfigurstion Manager
Sl S E:\Remotelnstall
Cafisid E:\SCCMEBackugp
Select Backup Date E:SCCMContentLin
E:\SMS_CCM
Select Recovery Type EA\SMS_SRSRP
E:\SMEPEG
s E/SMSPEGES
Spectfy Recovery Ogtions EASMSPRGSIG
. = EASMSSIGE
ESoftuarsDitibetion
Recovery Progress Er\System Volume information
Recovery destination: BN
Recovery option: Owvenwrite with recovered files
Security sstzings: Recover

To start the recovery process, run the setup from System Center Configuration Manager installation
media on the target server. Click on Install on the initial welcome screen.
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Microsoft System Center 2012 R2
Configuration Manager

Install /

ﬂ ngnanliayﬂé required
e Ecfore you begin

Toals and Standalone C 3 Additional Resources

53605 SEMVET TEATINESS Release fiotes

Get the lalest Configuration Manager updates Read Docementation

Install Configuration Manager console Cbtain instaltztion Assistance

Drownioad System Center Lipdates Publisher Connigurstion Manager Community
lownicad chients for additional aperating systems Canfiguration Manager Home

Browss the Installation Mediz

o a1 amonComsann At s =

On the Getting Started screen select Recover a site to recover the primary site.

Gettlﬂg Started

Setup has not detected an mxdsting installation of site server. site systern, or Carfiguration Manager le o this
camputer.

© Install a Configuration Manager primary sita
T™ Use typical installation-opticns for 3 stand-alone primary sits
- Install a Configuration Manager pimary st
- Use default installation path
- Configure loca! SQL Server with default sattings
- Enable a lozal ma point for C 3
- Enable 2 local distribution paint for Corfiguration Manager

I Instail a Configuration Manager central administration site
" |pgrade this Configuration Manager sie

Racaver a site
" Parfonm site maintenance or rasat this sits
€ Uninstall this Configuration Manager sie

< Bravious | Ness | Cancel

On the Site Server and Database Recovery screen browse to where the backup file location for both the
Site Server backup and Site Database backup.
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Site Server and Database Recovery Options
T [ — T

‘fou can recover a site server from an existing Configuration Manager backup set or reinstall the site server, If sefup has
detected an existing site installation on this computer, site server recovery settings are disabled,
1= Recower this site senser usin_g an axisting backup
Example: \\Filesanier| Backupshare\XY7Bzckup or ZABackuptX¥TEackup

Path: |E:\SCCMBnch.|p\PSDBackup Browse.. |

™ Reinstall this site server

You can recover the site :from an ensungf' ation Manag hacl:up set or Create 3 new database for this
site, Altemnatively, you can specify that the site Iy red by using & different method, or you
can skip database recovery when the site datebase mswu‘fkd::d by the disaster.

* Recover the site database using the backup set at the following location:
Example: \\Fileserver Backupshare) ¥YZBackup or TABackup'¥YZBackup

Path: |E.-‘-_SCC MEzckup\PSOBackaa Brovse..
[ Greate a new database for this site
 Usea : that has baen

™ Skip database recovery (Use this aption if the site database was unaffected)

< Previous MNext > | Cancel

If the backup is valid, on the Site Recovery Information page the setup wizard will detect the primary
site. Make sure that under Recover Primary Site option the Central Administration Site connection (CAS)
field is blank if the primary site was not connected to any CAS previously

Site Recovery Information
i. i - I i_\

When recavenng a central administration site, you have the aphion to specy a reference primary sits to use ac the
autharitatve source of data wheng,m 90 not have 2n existing site backup and when conflicts occur between primary
sites in the hierarchy. This option is dissbled when Sstup has detected that you are recovering a primary site,

When recovering 2 primary site, you have the option to specify the central administration site to which tha primary site-
was previously connected. Leave this setting blank when the primary site was not previcusly cannected to 3 central
administration site, This cption is disabled when Setup has detected that you are recovering a central adminisiration
site.

‘Select the type of site that you wanl to recover,
U Recover central administration sits

Reference primary site [FQDN]: Example: Server.contoso.com

& Recaver primarny site
Centrzl adminstration site [FOON): Bample: Serverl.contozo.com

<Previous | [ New> | cCancel

On the Product Key screen enter your SCCM Product License Key
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I Install the evaluation edition of this product

edition.

1% Install the licenced adition of this product

When you install the evaluation edition of this produrt. it is fully functional for 180 days. After installation. you can
enter the product kay fram the Site Maintanance aption in Setup ta upgrade tha evaluation edition 1o the licensed

On the next few screen Check “l accept these license terms” and click on Next until the Prerequisites

Download screen.

Microsaft Software License Terms.
[ S E— -

MICROSOFT EVALUATION SOFTWARE LICENSE TERMS
MICROSOFT SYSTEM CENTER 2012 R2 STANDARD

These Bcense tenms are an agreemant between Microsoft Corporation (or based on where you
live, ome of its affilates} and you. Pleass read them. They apply to the evaluation software namead
abowe, which indisdes the media on which you received It i any. The terms also apply t any
Microsaft

= updates,
o supplements,
o Internet-basad services, and

» SUppOt sarvices

for this software, wnless other terms accampany those mems. If so, thase terms apply.

By using the software, you accapt these terms. If you do not acoapt them, do not use
the software.

i

=

A LT R e ek S e ek bbb
Prin Ligense Terms % | ccept These Ierse tems,
<Pz || Nmes | canes

Prerequisite Licenses

| Pe———]

During Setug, Configumbon Manager will dawlsad and stare the fallowng softvware an the site server and then
il : ! i iy ok

o i By St i

Micrasaft 01 Server 2012 Fxpress
Ve the Microsoft S8 Server 2012 Exsress Licenss Terms
7 | accent thece Licerss Tarms

Micrasaft SOL Server 2012 Native Client
‘View the Microssft SO Server 1012 Motive Chient License Tarms
7 L accept these Licarse Terms

Wicrasaft Siverlight 3
This saftware will sutamaticaly updats afier instalistion.
Waew the Microsoft Silverfight 5 Licerse Terms online
Ve the Mieroseft Slverhght 5 Prvacy Statement geiline.

i vese License Terms s

Sikverlight

< previous || Wes |

Cancel

|

On the Prerequisite Downloads screen select Download Required Files and browse to an empty folder

e.g. Downloads on the SCCM volume, so that additional required files can be downloaded, and click

Next

Prerequisite Downloads.

-Symm(faernerZDTZ'RE-éaiw‘lgurasiun Manager Setup Wizard

= Downiaed required files

Setup requires presequisite files, Setup can automatically downinad the files o 2 location that you specify, or you con
usze files that have been downloaded previously.

\ Frayedes + c
Padh: |e downloads
C Usepr

Path

Dawniazdng Server CHT.cab ...

20f 5 fies
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On the Site and Installation Settings screen notice that Site code, Site name information has already
been filled from the backup files and cannot be edited. The Installation Folder can be edited and

changed**.

**It is recommended to use the identical volume drive letter and path that was used before

System Center 2012 R2 Configuration Manager Setup Wizard

Site and Installation Settings

Specify a site code that uniquely identifies this Configuration Manager site in your hierarchy.

Site code; PSO
Specify a site name that helps to identify the site. Example: Contoso Headquarters Site
Site pame: | Public Schaol Bistrict Site

Mote: The site code must be unigue in the Configuration Manager hierarchy and cannot be changed after you install the
site.

Instabation folde::\‘ 1E\'\Micrc-so!'t Configuration Manager Eronse...

Specify whether to install the Configuration Manager console to manage the Configuration Manager site from this
computer, You can remotely manage the site2 when you do not install the Configuration Manager consale.

I¥ Install the Configuration Manager console

<Previous | Mext» Cancel
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On the Database Information screen everything should be left as default and click Next. On the
Prerequisites Check screen click on Run Check to make sure all prerequisites pass and there are no
errors. Click on Begin Install if the prerequisites check passed without errors.

Database Information

=

5 S S
e i

with  static TEP port. Dyname ports e nat sippared.

that you e or the site database must be canfigured

T e

| SCEM- A zechaollocal

Enstance name (eave pank for oetaulty  Example: Mylnstance
|

Databace nama:

Eampl CM_5YT

[cmpsp

Spacify the TEP pert muntbsr-for S0 Server Service Brak

W i
4 3 1 Tha 3 the part ueed by the
S0 Serves serice which - detected by Candgu ""hw =
Senice Braker Fort
[anz2 -

Datanase Information
— |

Specify the focabans for the S Server dats file sed ranssction fog fe.

Path to the SOL Server data file

Path o the SOL Serves log file.

0\ Microsaft SOL Serven MESOL11MESOLSERVERMSSOL\DATA

Browss.

spevous | wewa |

Customer Experince Improvement Pragram
————

Do you wanil 1 Jain the Custamer Bperience Imprtavernent Program [CEF]?

e pregram calects izt ; harsviare st barw fan Mansger, withcut

inke I This heips improve C ior: Marager featunes. Mo i it is used fo
idartify o contact you.

fexd the CEIP prvacy statement online -

Biazd the pruacy ctatament anling.

I ottt

Exper g

= | dent want to jain the srageam et this time

Settings Summary
————
Setup il i Wiarager itk the ilowing setings.
Seings
Setus Cormprnsnt | 2
Setan Type Prirary sits recavary
Site Crde 50
Site Mame Public Schaal District Site
Prockict Ry AL
Inssaiasian Directory SiMicrasat Corfigumtion Mansger
Eiteiral File Fokder eaonnioas
0L Sarver SCCH-A- Lzshastizeal
556 Parr 022
Catabaze Name cMPen
50L Server data instalation dirsstary SHiMicrzaat: SQL SermrMSS0LT L MSSOLSE
SO0 Sarver bancaction istizes di \Microsoft SO SererMSSOLTT MSSOISE o]
Ta chimge these sethings, click Freveus, To apaly the setbngs : iar ite thack chick
s 2

Canced

et |

Preraquisits Check
————
Seiup i thecking Far potential installstian problems, If problerms are faurd Setup will display detais sbout how b
resive them.
Detaits:
Frerequisite sans | System | |
5L Server process memory sllocation Warning Eea T p—r—

Draraquissta chacking has complated.
LT TR LR LR ET LT EEE T

Select anitem to display details and rformation abaut how b resahve the proglem. Far & dsting af all prereguits - |
check resuits, see CanfiaharPrerey log.

Fun Check
< Previous. En Instal I Carcel .

Eisosed time: 000045

o nstall

& Gimeniing b Yy sid S0 Bvet reboete

el o |

98| Page



Once the installation is done you will get the Finished screen. There will be a list of Post-recovery
actions that will need to be addressed.

Finished
——(———

Post-recovery actions

You can find detailed information about the actions performed by the recovery process in ConfigMgrSetup.log. Te
complete the recovery of this site, you must manually complete the following actions not performed by Setup.

1. In the Configuration Manager conscle, re-enter the passwords for the following accounts.

Account Name I Account Type
SCHOOL\Administrator SMS_CLIENT_CONFIG_MANAGER

SCHOOL\sccm.admin SMS SRS Repaorting Point,
SMS AN SECTIRITY GRONIP DUSTOWERY AGENT

2. Reinstall the fellowing hotfixes,

URL ErmErs Site Role |
http:/fsuppert microsoft.com/KE/2938441 PrimarySite

3. For additional information about data not included in the Configuration Manager backup and recovery process, see
the product documentation (http://go.microsoft.com/fwlink/p/?Linkld=302304).

This information has been saved to C\ConfigMgrPostRecoveryActions.html for later reference.
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